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1.2

1.3

Getting Started

Welcome to the Perception Custom Software Interface (CSI). CSl is a powerful technology
which allows software integrators and Perception users to customize and automate (parts of)
the Perception software. As opposed to the 'standard’' API technology, programs written with
CSl form an integral part of the Perception software and are fully integrated in the Perception
user interface. They act like 'plug-ins'.

Introduction

While Perception and its options offer a satisfying solution for most measuring, processing and
reporting tasks, there are still some areas where the supplied software is not tailored to your
specific requirements.

A viable solution in this situation is to extend the Perception software with your own programs,
using Perception CSI. CSI stands for Custom Software Interface. Perception CSl is your
interface to the insides of Perception.

Writing your own program has the advantage that you have total control over your extensions,
while you keep the flexibility and power of the Perception environment.

Other 'standard' interface techniques allow you to add an external program that works in
parallel with the main application, either remotely or on the same machine. Using the
Perception CSI you create plug-ins that become part of the Perception application on the same
machine. These plug-ins have a user interface that is based on the Perception concept known
as 'sheets'. You will create a DLL that is linked into the Perception software at start-up, you
will not create a stand-alone executable (*.exe)

Besides sheets it is also possible to create your own:
e Functions: these can be used in the formula database to do your own specific
calculations
e Automation Actions: used to program special actions for the automation process
e User-key script actions: used to add special functionality behind user keys

Should you require external/remote control of the Perception software, then you should
consider using the Perception Remote Control option (a.k.a. Remote APl or COM-RPC).

This document describes a part of the CSl interface to Perception. It contains a command
overview and examples. Examples are written in C# using the Microsoft Visual Studio 2015
development environment.

Intended audience

CSl is designed to be used by C# ("See-Sharp") programmers. You must be proficient in this
programming language and Windows technology in order to write custom programs. This
documentation assumes you understand your HBM equipment, software, and basic acquisition
terminology.

Understanding acquisition terminology is vital to understanding digital recordings: trigger,
sample rate, pre-/post trigger, etc.

Requirements and installation

The HBM CSil is an option that is enabled through the use of the HASP®4 USB Token.
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This option is also listed as CSI: Custom Software Interface in the Perception menu:
Help > About Perception > More... > Options page

More About Perception g]

Options | Module versions

Analysis: Allows entry of Formulas bo calculate math channels like SUM 73
f; {Ch1+ChZ) or channel parameters like RMS (Ch1), Resulks can be reused in
Analysis,

Advanced Reporting: Enables multi page custom reports to be generated using
the internal Report shest or M5-Word and templates, These reports may
contain trace displays, user or cursor tables, pictures or user text,

IIHI|
iy

Infarmation: Enter comments and extended user information in Fully customized
entry masks, Entered information is stored with the experiment data and can
be used in reports, tables or the formula database,

=

CSI Runtime: Enables Custom Software extensions for Perception {created
using the Perception C5I option) to be executed. %

&

These extension can be extra controls, sheets, Formulas or others,

STL: A sef of special analysis routines according to the STL standards, Used in
LY, My and HY labs for analysis.
Includes import of TDG (Test Data Generator) data for verification,

I,

HPHY A&: An automated analysis process For HY and MY switchgear testing,
Cavers MoLoad, Short Circuit, Capacitive and Synthetic kest, Uses STL
calculations and built-in logic to validate waveshapes,

&

BE 256 | MultiPra control: Control a single BE2S6 or a single MultiPro mainframe
wia IEEE483 interface.
Mote: Only selected BE 256 | MulkiPro input boards are supported,

=

Sequencer: Creation/modification of timing sequences and communication with
BESZ00 Test Sequencer, v

Ok Cancel

[

In addition you must install the required software modules as described below.
1.3.1 System requirements

e HBM Perception software with CSI option enabled

e Microsoft® Windows-7 or later

e Microsoft DirectX 9 or higher (included on media)

e Microsoft .NET 4.6

e 4GB of RAM memory - 4 GB or more recommended and required when working with more

than one data acquisition mainframe.

1.3.2 Supported hardware

e HBM GEN Series Modular Data Acquisition System

1.3.3 Installation

Depending how you received your copy of the CSI Software Developers Kit do one of the
following:

e For a zipped download: unzip the file in a separate folder. In that folder run setup.exe.
e When you received the CSI SDK on a CD you must install the SDK from the CD onto your
hard disk; you cannot use CSI from the CD.

To install:

A2698_05_E00_00 HBM: public 9
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1. Start Windows and insert the CD in the CD-ROM drive.

2. Inthe Windows Task Bar click the Start button, point to and click Run....\

3. Inthe Run dialog type d:\setup (or e:\setup, depending on your CD-ROM drive
assignment) in the Open: text input field and click OK.

4. Follow the on-screen instructions.

e When you received the CSI SDK as part of the Perception installation CD, locate the CSI
folder on that CD. In that folder run setup.exe.

1.4 Starting CSI

CSI, when enabled, is part of the Perception software engine. When you start Perception you
have direct access to the CSI commands and functions.

1.4.1 To quit the Perception CSI

The Perception CSI is automatically closed when Perception is closed.

1.5 Where do you start?

Investigate the sample projects; decide which one is closest to the functionality you want to
provide. Run it in your software development environment and set breakpoints. The
documentation provided is intended as a guide with detailed explanation only where
appropriate; watching the information within the breakpoints is a good way to understand what
happens. Feel free to explore and experiment with the CSI on your own once you're familiar
with it, but please, resist the temptation to start from scratch until you're confident; you may
end up repeating other developers' mistakes, including your own.

This manual gives you only an introduction to the CSl interface; there are a lot more topics
which are not covered here e.g. Start Manager, Word Reporting, Sweep Deletion, Object
Manager, Excel Interaction, Sensor database, extending the RPC commands etc.

It is however also possible to join a Perception CSI training, for more information contact the
technical support or go to the HBM web site: HBM Perception APl or HBM Perception
Although the examples are created with Visual Studio 2017 it is also possible to use the free
Visual Studio Community IDE. You can download this version for free from the Microsoft
website.

10 A2698_05_E00_00 HBM: public
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2 Using Perception CSI

CSl is designed to give users access to the Perception internals. As opposed to standard API
programming there is no layer between the user software and Perception. Since the user
software is integrated, it is also created as a DLL instead of an executable. The user interface
provided is based on the Perception sheet concept. On a sheet, the user is free to build their
own interface. By default, a sheet comes with a proprietary menu.

One of the clear benefits of CSl is that it enables your organization to achieve a tight
integration between your knowledge and requirements and the Perception platform.

This approach also allows for customization on user request by independent software
integrators, in close cooperation with HBM.

2.1 What can you expect?

In this document we will describe a variety of functions, but not all and we will also not treat
every subject exhaustively.
The CSI SDK comprises:
e Access to all public and documented features:
o User modes
o Components and sheet manager
o Workbench:
= Workbook(s)
= File operations
= Sheet operations
o Perception DLL's, e.g.:
= Formula database
= Recordings
o .NETDLL's

e Starter kit: C# template for Microsoft Visual Studio

You cannot add functionality through other Perception components: you cannot modify existing
menus, graphs or displays, etc. You do have access to standard features. All this will be
explained in this document.

A2698_05_E00_00 HBM: public 11
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2.2 Usage of support files
For use with the Microsoft Visual Studio programming environment and C# a template is
provided. Depending on how you installed your CSI SDK and your computer environment this
file might already be installed. To verify, start your Microsoft Visual Studio 2019, and select
Extension >Manage Extensions

ﬂ File  Edit View Debug Team  Analyze Tools | Extensions | Window  Help S
b . e W . . [E Manage Btensions ' |

In the dialog that comes up type Perception in the right upper search box:

Manage Extensions ? X
4 Installed Sort by: [Most Recent -] Perception X |-
All 2 Perception.ScriptAction.Template Disable Created By: HBM
Controls Perception script action template Date Installed: 28-Feb-20
Templates Version: 3.0.19142.1200
SDKs :
" Perception CSl Sheet Project Template More Information
Tools “J * Perception CSl Sheet [V Automatically update this extension
Search Results
Scheduled For Install:
b Online Mone
b Updates Scheduled For Update:
b Roaming Extension Manager biens
Scheduled For Uninstall:
Neone

Change your settings for Extensions

Close

In the Template section, the Perception CSI sheet should be available. If not so, proceed as
described below.

2.2.1 To load the Perception CSI template

1. Locate the file named Perception CSI Sheet Project Template.vsix

2. Double-click this file. The VSIX installer will be launched:

[ VSIX Installer (3]

Perception CSI Sheet Project Template

Select the product(s) you want to install the extension to:

Microsoft Visual Studio Professional 2015

This extension does not contain a digital signature.

This extension did not specify license terms in its manifest that are
readable by VSIX Installer.

By dlicking "Install”, you agree with the

above license terms (if any). Jostail | [ Lancel

3. Click Install to install

12 A2698_05_E00_00 HBM: public
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[ VSIX Installer (=2

Installation Complete

Your extension has been successfully installed. Please close and
restart all target application instances for changes to take effect.

) Microsoft Visual Studio Professional 2013

View Install Log

4. Click Close

2.3 Your first CSI program

You now should be able to create, compile and run your first CSI program.
To do so proceed as follows:

1. Start your Microsoft Visual Studio and select Create a new project.

What would you like to do?

Open recent Get started

| P~ J

— Clone or check out code

Get code from an online repository like GitHub or
Azure DevOps

<')@ Open a project or solution

Open a local Visual Studio project or sin file

- Open alocal folder

Mavigate and edit code within any folder

"'@ Create a new project

Choose a project template with code scaffolding
to get started

In the dialog that comes up select C# in the first selection box.
Perception in the second selection box.

All project types in third selection box

a ~ v

The Perception CSI Sheet template selection should now be visible:
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Create a neW project Search for templates (Alt+5) P -

Clear all

Recent project templates c v Perception ~ Al project types -

" Perception CS| Sheet
—

Windows Forms App (MET Core) c# i 4
d Perception C5l sheet template

# Windows Perception sl Perception Sheet

& Perception.Scriptiction
Perception Script Action

c# Windows Perception sl Perception Script Action

Mot finding what you're locking for?
Install more tools and features

6. Select the Perception CSI Sheet template
7. Enter a name MyFirstCSI and location for this project and click OK

%
Configure your new project
Perception CSI Sheet ¢ windows  Perception €SI Perception Sheet
Project name
MyFirstCSl
Location
C\Users\Damme\Decuments\Perception\ C5l Training\Lab 01\ = |:|

Solution name

Place solution and project in the same directory

Back Create

The Solution Explorer will now include the following:

14
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Solution Explorer *Aax

@ o-c¢am|F

Search Solution Explorer [Tpogocp ] P~
fa] Solution 'MyFirstCSJWc}t]
4 MyFirstCSI
4 & Properties
c# Assemblylnfo.cs
3 Resources.resx
4 =B References
& Analyzers
=B Perception Interfaces
=B Perception Interops
=0 System
=B Systemn.Data
=0 Systemn.Drawing
=B Systern.Windows.Forms
=0 Systern.Xml
4 Resources
Sheetlcon.ico
4 g1 SheetControl.cs
b 7Y SheetControl.Designer.cs
B c# SheetControllnfoProvider.cs
I ©* SheetControllnfoRetriever.cs

Solution Explorer REETANSTIRTE

e Areference to the Perception Interfaces
e C# code for the SheetControl

This code is enough to create a sheet in Perception. Before we can build it, we need to add
some more information to the project itself.

Optionally give the sheet a name and icon other than default:

1. Goto Project > <Project Name> > Properties

2. Goto Resources > Strings and modify the text from IDS_USERNAME into your
sheet name and add a descriptive text for your sheet.

3. Goto Resources > Icons and select Add Resource > Add Existing File. Browse to
and select your own icon file.
Remove the default icon
Rename your icon into "Sheeticon”
Go to Debug-> Start external program and enter the full name where Perception.exe is
located, default this will be: “C:\Program Files\HBM\Perception\Perception.exe”

Mandatory:

Go to Project > Project Name Properties

Go to Build > Output > Output path

Verify the output path: C:\Program Files\HBM\Perception\Sheets\CSI
Go to Build > Configuration and select Release

a c w e

In the main menu select Build > Build Solution

When all is OK, no error messages are generated. However, ignore warnings for the time
being.

When error messages are generated verify all of the above steps. Also make sure you have
the latest version of the template and the latest version of Perception.
Use the Windows Explorer to have a look in the output directory.
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(-

C:\Program Files\HBM\Perception\Sheets\CS|

Eile Edit Yiew Favorites Tools Help

@Back ) L@ /':_jSearch |7 Folders | (2]~

Address | [23) C1\Program Files\HEM\Perception\Sheets\CS1

V‘GD

[y Size | Type
32 KB Application Extension

File and Folder Tasks

qﬂ Rename this file 24 kKB

ﬁ Movwe Ehis File

Copy this Filz

e Publish this file to the Web
() E-mail this file

€ Delete this file

Other Places

() Sheets

ﬂ My Documents

d My Computer

lj Iy Mebwork Flaces

Details

MyFirstCSLdll
Application Extension

Date Modified: Today, April 23,
2008, 12:17 PM

Sizet 32.0 KB

Program Debug Database  23-04-2009 12:17 PM

Date Modified
23-04-2009 12117 FM

Between the already installed sheets you will see the one we just created.
To verify the operation, start Perception.

ELLLLL bttt ittt ik

eption (Primar’’)

Automation CSIDemo 1 Window Help

L@ E

-

Active | [ Settings | 7] Information || £4 Formula| ) Report | #] 51 Demo 1 k

You should now see the:

A. Default menu for your sheet

Sheet icon

O 0w

Empty sheet area

Sheet name

Note: the output path as specified in the Build section of the Project Properties should
be the same for each Configuration: debug as well as release.

Now we know that the basics are functioning.
In the next chapter we will have a look into the code and structure of the template.

16
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3 Perception CSI Template

This chapter of the document describes the fundamentals of the provided template. The
template comprises all available functions required to communicate with Perception, as
demonstrated already in the previous chapter: without writing one line of code we were able to
create a sheet. However, the template is more: it is the starting point of complete integration of
your application specific software and Perception.

3.1 The fundamentals of Sheet interfacing

Perception uses a Sheet Manager to control Sheets. The fundamental information of a sheet is
provided by the code in SheetControlinfoProvider.cs.

3.1.1 Sheet Control Information Provider

In the SheetControlinfoProvider.cs the Perception Sheet Manager can find information like:

e Sheet descriptive name
e Sheet descriptive icon
e Preferred sheet index

e Can we create more than one instance of the sheet, automatic or manually

This information is used even before a sheet is created.

Before we create a sheet we must determine if we want the sheet to be automatically created
or not. The following options are available:

¢ Not manually creatable: the sheet is created automatically by Perception at startup

e Manually creatable: the sheet is not created automatically by Perception at startup,
you need to add the sheet manually. You can create multiple instances of your sheet.

e Manually creatable only once: the sheet is not created automatically by Perception
at startup, you need to add the sheet manually. You can create only one instance of
your sheet.

In the SheetControlInfoProvider.cs the code is as follows:

public ManuallyCreateType ManuallyCreatable
{
get
{
return ManuallyCreateType.NotManuallyCreatable;

}

This is the default situation as shown in the previous chapter. Now change the return value
into:

||return ManuallyCreateType.ManuallyCreatableSingleInstance;
and build the solution again. If you now Start Perception you will see that no sheet is loaded.

To load the sheet, do one of the following
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In the File menu point to New Sheet and select the sheet in the submenu that comes up.

In the toolbar click the New Sheet icon. In the menu that comes up select the sheet. (see
below)

7

=i Diagnostics Viewer
€. User Sheet

¢ CSIDemo 1

Do a right mouse-click in the tab area of the sheets. Point to New Sheet and select the
sheet in the submenu that comes up.

You can modify the position of the sheet tab in the row of sheet tabs, when the sheet is
automatically created (default). You can do this in the following code:

public int PreferredSheetIndex
{
get
{
return -1;

}

The first position (index = 0) is reserved for the Perception Active Sheet. Use a return value of
1 for the second position, 2 for the third position, etc. Use -1 for default.

You can modify the name and icon as shown in the New Sheet list by modifying the
corresponding code, e.g.

public string Name
{
get
{
return "Creates a demo CSI sheet";
}
}

public Icon Icon
{
get
{
return null;

}

Now these settings are used for the New Sheet menus.

IIQ] Mew Sheet » l [3 Diagnostics Viewer
8 User Sheet

Creates a demo CSI sheet

Note that the Sheet itself still has the name and icon as defined earlier.
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3.1.2 Sheet Control Information Retriever
In the SheetControlinfoRetriever.cs the Perception Sheet Manager can find information like:
e Sheet description

The sheet description is used by the Sheet manager

Manage Sheets @

Wiew and manage all your Perception sheets

Select a sheet to load or remove in this particular Yitual WorkBench, You can alzo define the default Perception startup action for a selected sheet,

Selected sheet Mame Description Current Status Startup Default
;-ﬂ CSl Demo 1 Perception Standard

o] chive The active sheet by default hag a single dis..  Loaded [visible] Shaw
j Diagnostics Yiewer Gives easy access to a list of events that o Nat loaded Don't load
|3 Fiber Status Gives access to an extensive set of on-boa.. Not lnaded Dar't load

Load 4 Formulas Create additional functions without program...  Loaded [vizible] Shaw
Desciintion: ¥ HPHY Automated Analysis High*Voltage, High-Power dutomated &nal... Mot loaded Don't load

.ﬂ Information Add additional information to be stared per.. Loaded [visible] Show

] Reporting WhYSPWYG Reporter delivers professional .. Loaded [visible] Show
& Sequencer Communicate with and contral the BE3200 .. Not loaded Don't load

E Settings All hardware related settings are accessible Loaded [vizible) Shaw

Csl
S This is my first C51 example sheet Loaded [visible] Show

Startup default

Select the Perception default startup
action for this sheet. This defines the
sheet behavior when you start
Perception, load a new blank,
experiment or start with an
auto-configured experiment,

Clase

3.1.3 Sheet Control

The file SheetControl.cs has all the fundamentals on board to communicate with the
Perception application itself. The source code provides five main regions:

e Members

e Constructor

e Sheet Members

e Serializable Members

e Disposing

We will discuss these in the following sections.
3.1.4 Members

The members region comprises the members of the sheet interface:

m_strUserName
e m_iProgram

e m_UlState

e m_lInitializeState

e m_bDisposed
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and are defined as follows:

private string m_strUserName = Properties.Resources.IDS_USERNAME;

private IProgram m_iProgram = null;
private UIState m UIState = UIState.Invisible;
private InitializeState m_InitializeState = InitializeState.Unknown;

private bool m bDisposed = false;
m_strUserName

This is the name we already have defined in the resources.
m_iProgram

The interface to the Perception program. This member interfaces to the ComponentManager,
Experiment, SheetManager, UserMode, Workbench and ApplicationSettings. So far we
have already used the SheetManager and in this section we will also see the use of the
UserMode.

m_UIState

This member (User Interface State) defines the "visibility" of the sheet. Initially this state is set
to invisible. When Perception loads the sheet, this state is set to visible, unless we decide not
to do so, as will be explained later.

You can see the state-change in action. To do so:

* Make sure that you have set in the project properties:
o Debug > Configuration: Active (debug)

o Debug > Start Action > Start external program: <Perception>

* And the output window available.

In the source code go to the Events region > Properties region and locate the code for the
UlState. Now modify the code as follows:

public UIState UIState

{
get
{

return this.m UIState;

}

set

{

this.m UIState = value;

System.Diagnostics.Debug.WriteLine ("UIState is now " +
this.m _UIState.ToString()) ;
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When Perception changes the UlState of the sheet, program execution will enter the UlState-
set. Here we enter code to display the UlState in the debug output window.

Start debugging and see the various state-changes.

Qutput v 3 X
Show output from: Debug zila a =74 =

Perception.exe Warning: 0 : GetDynamicToolBar for Sheet 'Active' failed: P
UIState is now Active

UIState is now Invisible

UIState is now Active

UIState is now Visible

UIState is now Active

The thread 0xcé4 has exited with code 0 (0x0). N

(=] Output

You can use this entry point for various functions. E.g. when you are running a video on your
sheet, you can pause the video when the sheet becomes invisible and resume playing when
the sheet becomes active again. (active = running + visible)

m_InitializeState

One of the first things Perception will do when it creates a sheet is verifying the initialization
state. This is done before the sheet is created. The following states are currently supported:

InstalledIincorrectly: currently not used

* NotAllowed: do not create the sheet

* Succeeded: all initialization is OK, create sheet

* Unknown: unknown

As an example, you could create a sheet that is always visible unless the user mode is 'review
only', i.e. no control allowed.

In the source code go to the Events region > Methods region and locate the code for the
InitializeState. Now modify the code as follows:

{

{

}

else

{

}

public InitializeState Initialize(IProgram iProgram)
this.m_iProgram = iProgram;
if (iProgram.UserMode == UserMode.Review)
this.m InitializeState = InitializeState.NotAllowed;
Messag;ﬁox.Show(this,"You cannot use this sheet in review mode.",

"CSI Demo 1", MessageBoxButtons.OK, MessageBoxIcon.
Exclamation) ;

this.m InitializeState = InitializeState.Succeeded;

return this.m InitializeState;

In this section you can also do other tests and initializations before the sheet is created.
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Combine this with message boxes for user feedback. Note that the Initialize code is only
executed once: the first time the sheet is created. When you hide and restore the sheet this
code will not be executed.

Make sure that the sheet is ManuallyCreatableSinglelnstance and do all the things we have
done before, but now start Perception in Review mode. When you want to add the sheet the
messagebox will come up

€SI Demo 1 %

L] "_-. ¥ou cannaok use this sheet in review mode,
L]

and the sheet will not be created.

m_bDisposed

This variable is used during the CleanUp() procedure to prevent you repeat the cleanup again.
Constructor

There is only one constructor that is required for Designer support and creates a sheet control
object.

3.1.5 ISheet Members

These are the most widely used functions to interact between the sheet and the Perception
application. These members are divided into the three main categories:

* Events provide a way for a class or object to notify other classes or objects when
something of interest happens. The class that sends (or raises) the event is called the
publisher and the classes that receive (or handle) the event are called subscribers.

* Properties are members that provide a flexible mechanism to read, write, or compute the
values of private fields. Properties enable a class to expose a public way of getting and
setting values, while hiding implementation or verification code.

* Methods are a code block containing a series of statements. In C#, every executed
instruction is done so in the context of a method.

3.1.6 Events

Each sheet has its own menu and optional toolbar. When you go from one sheet to another,
the corresponding menu/toolbar comes up. These are called dynamic menu and dynamic
toolbar as opposed to the standard (static) menus and toolbars that are available within
Perception. There are three events defined that are related to this dynamic behaviour:

+ UserNameChanged Use this event when you modified within your 'application' the name
of the current sheet.

+ ToolltemsUpdated Use this event to notify Perception that something has happened to
the dynamic toolbar.

*+ RebuildDynamicMenuRequested Notify Perception that you want to rebuild the menu.
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In the next example we will demonstrate the use of UserNameChanged and
RebuildDynamicMenuRequested.

In this example we will start with adding some user interface to our sheet. To do so, start the

SheetControl.cs in Design mode and add two common controls: a TextBox and a Button,
grouped in a GroupBox container as follows:

A B Cc

l ShegtControl.cs [Design]

Leet name

U

A GroupBox
B TextBox "textBox1"
C Button "button1"

The operation will be as follows: initially the TextBox is disabled and contains the sheet name.
When you click on the Button the TextBox is enabled for editing and the text of the Button

changes into "Enter". Now you can modify the sheet name. Click the Button again to conclude
the modification.

The initialization code is placed in SheetControl_Load, the other code is placed in the
buttonl1_click event. The complete code could look like this:
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private void SheetControl Load(object sender, EventArgs e)
{

m_bEditFlag = false;

textBoxl.Text = m_strUserName;

textBoxl.Enabled = false;

private void buttonl_Click (object sender, EventArgs e)
{
if (m_bEditFlag == false)
{
buttonl.Text = "Ené&ter";
textBoxl.Enabled = true;
m_bEditFlag = true;
}
else
{
UserName = textBoxl.Text;
buttonl.Text = "Edi&t";
textBoxl.Enabled = false;
m_bEditFlag = false;

// Fire the RebuildDynamicMenuRequested event to update the
// dynamic menu name and toolbar

if (this.RebuildDynamicMenuRequested != null)
this.RebuildDynamicMenuRequested (this, new EventArgs()) ;

In the SheetControl_Load we initialize a state flag that has been defined as member in the
Members > ISheet region as :

||private Boolean m_bEditFlag = false;

The textbox is initialized as defined with user name and disabled. Note that the
SheetControl_Load code is only executed once: the first time the sheet is loaded after
creation. When you hide and restore the sheet this code will not be executed.

When you click on the button, initially the textbox is enabled, the button text changes and the
flag is set to true.

Now you can edit the text.

When you click on the button for the second time, the text from the textbox is passed to
"UserName" as argument.

UserName is defined in the Events > Properties region. It gets and sets the sheet name.
When the sheet name is modified, it fires the UserNameChanged event. This allows
Perception to react on this event and modify the sheet name in the tab of the sheet.

After this the button text is modified, the textbox is disabled and the flag is set to false again.

Although Perception will update the sheet name in the tab of the sheet, it will not automatically
update the name of the dynamic menu at once. In order to do this, we need also to fire the
RebuildDynamicMenuRequested event. To do this test if a change is made and if so, fire the
event.

To test this piece of software set the sheet to be ManuallyCreatable in the
SheetControlinfoProvider. This allows for multiple instances of the sheet.
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3.1.7

Now you can start debugging.

When Perception is launched in any user mode - except Review only - you can add this sheet.
Modify the name as described earlier.

MyDemo Window Help
rD000E B EBRE

? X |5 Active ESettings d Information || fd Formula | 23 Report \i\'{MyDemo

:] Sheet name

Dynamic menu
Sheet tab
Text box with new name entered

Edit / Enter button

o O W >

You can add multiple sheets and give each sheet its own name.

Properties

A sheet has several properties. Perception uses these properties. Therefore these properties
must be available to Perception. Some of the properties are read-only, others are read-write

properties.

These properties are defined in the ISheet > Properties region. Currently the following
properties are available:

+ UserName (R/W) The sheet name
* MenuName (R) The name of the dynamic menu, usually the same as the sheet name
* lIcon (R) Sheet icon

+ DeleteActiveltemSupported (R) When an object on a sheet is active it can be deleted or
not (default = no)

+ UlState (R/W) User interface state, e.g. visibility
+ InitializeState (R) Gets the initialization state of the sheet
UserName

The User name / sheet name already has been discussed in detail in the ISheet Members >
Events section.

MenuName

The menu name is a read only property. By default it is set to the user name. However, you
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can modify it to be any other name. E.g. when you own a company that manufactures
everything, called ACME, you would like the menu header to be ACME also. This has
advantages when:

* You want your name to be on top of the menu, regardless of the name of the sheet

* You want your name to be on top of the menu, even if you have multiple instances of a
sheet with different names

* You want your name to be on top of the menu, even if you have multiple types of sheets

Please not that although the name remains the same, the dynamic menu contents depends on
the selected sheet.

You could modify the MenuName properties as follows:

public string MenuName
{
get
{
if (String.IsNullOrEmpty (this.m strUserName))
{
// Return a string from the resource table when no current
// User Name is available
return Properties.Resources.IDS_USERNAME;
}
else
{
// Return the current User Name or selected name
return "ACME Company";

If you run the previous example (modify user name of sheet) with these modifications and
make two instances of the same sheet, you will notice that the menu name remains the same
and that the contents of the dynamic menu is related to the selected sheet.

Ilcon

The Icon property is read only. You could choose to modify it, although there is no valid reason
to do so.

DeleteActiveltemSupported

When you want to have the possibility to Delete items on your sheet, you must inform
Perception to do so. This is done through the DeleteActiveltemSupported property. By
default this is set to 'false’. When you want to have this option, you need to set this property to
true. When the menu is pulled down, Perception interrogates this property and once the option
is set to true, the Delete command in the Perception Edit menu comes available.

As an example add a listbox with some items to your sheet:
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3.1.8

Sheet name

Enter some items and modify the property code as follows:

public bool DeleteActiveItemSupported
{
get
{
return ((listBoxl.SelectedIndex >= 0) &&
(m_bEditFlag == false));

When nothing is selected in the listbox, it will return false, otherwise true, i.e. when nothing is
selected there is nothing to delete, so the command is not available. This is combined with the
textbox edit: when the textbox edit is (also) active, the command is not available since a
textbox has its own edit-handling.

Note that keyboard handling must be done by yourself. The Delete command in the Edit menu
is merely a 'goodie' to get you started.

When a delete command is issued, Perception enters the DeleteActiveltem code that is

defined in the ISheet Members > Methods region. Modify as follows:

public void DeleteActiveItem()

{
listBoxl.Items.Remove (listBoxl.SelectedItem) ;

Here you will need to implement the code required to perform the delete action, i.e. you need
to find out which object is selected and perform an adequate delete action. In the above
example the selected item will be deleted from the listbox.

UlState

The UlState has been described extensively in the section on the sheet control members:
m_UlState.

InitializeState

The InitializeState has been described extensively in the section on the sheet control
members: m_|InitializeState.

Methods

A sheet provides a number of methods. Perception uses these methods. Therefore these
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methods must be available to Perception.

These methods are defined in the ISheet > Methods region. Currently the following methods
are available:

+ UpdateMenultems Update the contents of the dynamic menu

+ DeleteActiveltem Code executed when a delete command from the Edit menu is issued
* AutoConfig Code for the auto-configuration feature

* Initialize Code executed when Perception initializes the sheet

» PostLoad Executes code when a new settings file has been loaded

* GetDynamicMenu Here comes the code that takes care of the creation of a dynamic
menu

+ GetDynamicToolbar Here comes the code that takes care of the creation of a dynamic
toolbar

This section describes these methods in a different order than provided in the template.
DeleteActiveltem

This method already has been discussed in the section on the ISheet Members > Properties
> DeleteActiveltemSupported.

AutoConfig

When you start Perception or select File > New, you have the option to let Perception create a
"default” layout based on the hardware it finds.

You can also use this auto-configuration feature. E.g. you can load the drop-down list in the
previous example with values based on preferences or any other reason. Currently this only
works for sheets that are automatically created, i.e. not manually creatable.

Assume you want to fill the list with all available recorders within the mainframe that was
selected during auto-configuration:

public void AutoConfig()
{
listBoxl.Items.Clear() ;
CtrlAcquisitionSystem AcqSys = CtrlAcquisitionSystemFactory.Create()
CtrlGroup GroupAll = AcgSys.Groups.GroupAll;
foreach (CtrlRecorder Recorder in GroupAll.Recorders)

{
listBoxl.Items.Add (Recorder.Name) ;

}

First we clear the listbox contents. The next two lines will be explained in more detail in
another section of this manual. For now: we create a group of recorders based on the group
"All" of the acquisition system. This is the same group as you will find in the Perception
Hardware Navigator.

Once we have this group we loop through all available recorders and display their name.

To test this piece of software set the sheet to be NotManuallyCreatable in the
SheetControlinfoProvider.cs. This will create the sheet automatically.
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First start Perception and do not use the auto configuration mode. Then select File > New...
and select auto-configuration. In the Select Mainframe dialog that comes up select a
mainframe.

Sheet name Sheet name

itemn1 ~ Recorder & ~
item2 Recorder B
item3 Recorder C
itemd N Recorder D ¥

Now the contents of the listbox will be updated. An example is shown in the diagram above:
left is the situation before the auto-configuration, right you see the situation after the auto-
configuration.

Initialize
This has been discussed in detail in the section on Members > m_InitializeState.
PostLoad

When Perception loads a new settings file it also executes the sheet code PostLoad. Here
you can enter your code. This could be the same kind of code as you would do after an auto-
configuration, e.g. loading a list with the available recorders.

GetDynamicMenu

This method is called when Perception want to display the dynamic menu. By default the
dynamic menu has already two entries: move and delete sheet. The other entries are defined
by the sheet.

To add items to the dynamic menu you must create a context menu strip in the sheet user
interface. This menu is not actually deployed but used as a piece of menu transferred to the
dynamic menu.

To add items to the dynamic menu

1. Inthe programming environment add a tool strip menu to your user interface: Toolbox
>Menus & Toolbars > ContextMenuStrip

2. Use Edit Iltems ... to add/modify menu items

3. Add the following code:

public ToolStripItem[] GetDynamicMenu ()
{
ContextMenuStrip strip = contextMenuStripl;
if (this.IsDisposed || this.Disposing || (strip == null))
return null;
ToolStripItem[] aToolArray = new ToolStripItem[
strip.Items.Count];
strip.Items.CopyTo (aToolArray, O);
return aToolArray;
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Here we create a ‘toolstrip’ item called aMyltems based on the size of the designed
contextMenuStrip. After this we copy the contents of the contextMenuStrip to our toolstrip
and return this toolstrip.

4. Run the program

[ ACME Company L

Menultem 1

Menultem 2

Move Sheet 'CSIDemo 1'to »

't Delete Sheet 'CSI Demo 1"

You will see that the new commands are added. In a next chapter we will go into more detail in
using the menu.

UpdateMenultems

Menu items can be modified during program execution. E.g. when a start acquisition command
is part of your menu, this command should be disabled while acquisition is active. A good
moment to update your menu information is just before the menu becomes active, i.e. drops
down. Now you are sure you have the latest information.

This function is provided through the UpdatMenultems method.
Example:

public void UpdateMenultems ()

{
menuIltemlToolStripMenultem.Enabled = !m bEditFlag;
toolStripButtonl.Enabled = !m _bEditFlag;

Depending on the edit state of the sheet name as we have used so far, the second menu entry
is disabled or enabled.

GetDynamicToolBar

In very much the same way as we created a dynamic menu, you can also create a toolbar
related to your sheet. Instead of creating a context menu strip, you now create a toolstrip and
modify its contents. Once created you can use the following code:

public ToolStripItem[] GetDynamicToolBar ()
{
ToolStrip strip = this toolStripl;
if (this.IsDisposed || this.Disposing || (strip == null))
return null;
ToolStripItem[] Result = new ToolStripItem|[
strip.Items.Count];
strip.Items.CopyTo (Result, 0);
return Result;

Make sure you have set the visibility to false.
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3.1.9 ISerializable Members

This region contains the GetObjectData and SheetControl procedure that allows you to
save/load sheet specific information when the vwb is saved/loaded. For each item that you
want to save, choose a unique name and create an entry in the data stream to be saved as
follows:

public void GetObjectData (SerializationInfo info, StreamingContext context)

{
info.AddValue ("ModifiedSheetName", m_strUserName, typeof(string));

For each item add a line. In the above example the current sheet name m_strUserName is
saved in the string variable named ModifiedSheetName.

Once saved you can restore the data when the same vwb is loaded as follows:

public SheetControl (SerializationInfo info, StreamingContext context): this()
{
m_strUserName = Tools.GetValue<string>(info, "ModifiedSheetName",
m_strUserName) ;

Here the saved string in variable ModifiedSheetName is restored into m_strUserName.
When no data is available, the third parameter in GetValue is used as default. Typically this is
the initialized version of the variable to be restored.

3.1.10 Disposing

This region contains the code where you can add your own dispose code. It contains the
following generated lines:

private void SheetDisposed(object sender, EventArgs e)
{

if (IsDisposed) return;

if (m_bDisposed) return;

try
{
// Add your clean up code
}
catch
{
}

m_bDisposed = true;

Use this function if you want to release (e.g.) objects you are using.

private void SheetDisposed(object sender, EventArgs e)
{

if (IsDisposed) return;

if (m_bDisposed) return;

m_Datamanager = null;

m_bDisposed = true;

Later on in this manual we will come back to the meaning of the DataManager
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4  Acquisition Control

One of the first actions when creating your own software is usually to see if you can control
acquisition. In this chapter we will demonstrate the fundamentals of acquisition within the
Perception software. Not only will we demonstrate how to create your own acquisition control,
but also how to read acquisition status and how to implement a good user interface that
complies with Perception as well as common guidelines for user interfaces.

4.1 Basic acquisition control

In this section we will describe the implementation of basic acquisition control as well as the
steps required to implement hardware interfacing.

4.1.1 Getting started

Create a new project as described earlier with the correct name, icon and “creatability”. To get
started we will:

* adda'using' directive
» create an acquisition control object
» initialize program and object
Acquisition control is 'hosted' by the Perception.ILO. ILO stands for Intermediate Layer
Objects, these layer objects are used to interface with the connected mainframe(s). Since we
will be using the ILO multiple times, we will add a Using Directive at the beginning of the
source code where already other directives are placed. Add this directive below the other CSI
directives:

using Perception.Sheets;

using Perception;
using Perception.ILO;

Since we want to control an acquisition system, we will need to create an acquisition system
object:
In the Members region add a region below the ISheet region as follows:

#region -> MyMembers

private CtrlAcquisitionSystem m MyDemoSystem = null;
private CtrlGroup m_GroupAll = null;

#endregion
We now have a member that is a control of an acquisition system. The other member is
m_GroupAll, the type of this member is CtrlGroup. This member variable will point to the

GroupAll, this group is always available and contains all available recorders in the system.

Initialization will be done in the Initialize method as follows:
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public InitializeState Initialize (IProgram iProgram)
{
if (iProgram.UserMode == UserMode.Review)
{
m InitializeState = InitializeState.NotAllowed;
}
else
{
try
{
m_iProgram = iProgram;
m_MyDemoSystem = CtrlAcquisitionSystemFactory.Create();
m_GroupAll = m_ MyDemoSystem.Groups.GroupAll;
m InitializeState = InitializeState.Succeeded;
}
catch
{
m_InitializeState = InitializeState.NotAllowed;
PerceptionMessageBox.Show(this, "Could not initialize sheet",
"CSI: Catch", MessageBoxButtons.OK, MessageBoxIcon.Error) ;

}

return this.m InitializeState;

We start again with a simple test: when in review mode the sheet cannot be loaded.

In the following section we perform a basic test: when an error occurs within the try section,
the catch code is executed, i.e. when the connection to Perception fails or when we cannot
create an instance of the acquisition control object, the sheet is not loaded.

We can now start with the user interface.

4.1.2 The user interface

We will start with a very basic user interface. Also the code behind this user interface will be
very elementary. Create a design as follows:

A B C
| SheftControl.cs +7esign] i
l Acquisition contr

Start Stop (=}

A. GroupBox
B. Button "StartCmd"
C. Button "StopCmd"

For the time being we will initialize the buttons when the sheet becomes active: when no
acquisition system is found, the buttons are disabled, otherwise the Start button is enabled.
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public UIState UIState
{
get
{
return this.m UIState;
}
set
{
this.m UIState = value;
if (this.m UIState == UIState.Active)
// sheet becomes active
{
if (m_GroupAll.Recorders.Count == 0)
// no hardware -> no control
{
StartCmd.Enabled = false;
StopCmd.Enabled = false;
}
else
{
StartCmd.Enabled = true;
StopCmd.Enabled = false;

The Start button is used to start an acquisition for all recorders. Also some acquisition
parameters are set as example.

Enter the code for the Start button:

private void StartCmd_Click (object sender, EventArgs e)
{
// for demo purposes -> set some acquisition parameters here
// 10 kSamples at 10 kHz with trigger position at 50%
foreach (CtrlGroup myGroup in m MyDemoSystem.Groups)
{
if (myGroup.SupportsTimebase)
{
myGroup . SweepLength = 10000;
myGroup.TriggerPosition = 50;
myGroup . HighSamplingFrequency = 99990.0;
}
}

m_GroupAll.Run() ;
StartCmd.Enabled = false;
StopCmd.Enabled = true;

For ease of use we start all recorders within all recorder groups at the same time with the
same settings.

To do this we loop through the recorders collection within the GroupAll group of our
acquisition system m_MyDemoSystem.

For each recorder we find we set the sweep length, trigger position and sample rate.
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4.1.3

When done, the acquisition is started and the buttons are enabled or disabled as appropriate.
The Stop command is easier:

private void StopCmd_Click (object sender, EventArgs e)
{

m_GroupAll.Stop() ;

StartCmd.Enabled = true;

StopCmd.Enabled = false;

When you run this program, you will notice some issues with respect to the update of the
buttons. E.g. when you trigger an acquisition, the recording will stop but the buttons will not be
modified. This is because we do not 'respond' to changes in the acquisition status. To do this
properly we need an event handler that responds to the various event changes.

Event handling

As in real life it is sometimes not a bad idea to respond to events that happen instead of having
to look all the time to a status.

In our environment we will do that by creating an event handler that responds to events fired
by an object. In our situation we will respond to events fired by the GroupAll object. The
GroupAll object is defined as follows in the MyMembers section:

“private CtrlGroup m_GroupAll = null;

and initialized in the Initialize method:

“this.m_GroupAll = m_MyDemoSystem.Groups.GroupAll;

after the initialization of m_MyDemoSystem.

We will always try to use hook and unhook functions to manage the event procedures in our
program.

Therefore, you should create the following functions:

private void HookToGroupAll ()
{
UnHookFromGroupAll () ;
if (m_GroupAll != null)
{
m_GroupAll.AcquisitionStateChanged +=
GroupAllAcquisitionStateChanged;
}
}

private void UnHookFromGroupAll ()
{
if (m_GroupAll != null)
{
try
{
m_GroupAll.AcquisitionStateChanged -=
GroupAllAcquisitionStateChanged;
}

catch
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The complete code segment will now look as follows:

public InitializeState Initialize (IProgram iProgram)

{

if (iProgram.UserMode == UserMode.Review)

{
this.m InitializeState = InitializeState.NotAllowed;

}

else
{
try
{
this.m_iProgram = iProgram;
this.m MyDemoSystem = CtrlAcquisitionSystemFactory.Create()
this.m GroupAll = m MyDemoSystem.Groups.GroupAll;
HookToGroupAll () ;
this.m InitializeState = InitializeState.Succeeded;
}
catch

{
this.m InitializeState = InitializeState.NotAllowed;

PerceptionMessageBox.Show(this, "Could not initialize sheet",
"CSI:Catch", MessageBoxButtons.OK, MessageBoxIcon.Error);

}

return this.m InitializeState;

void GroupAllAcquisitionStateChanged(object sender, int Running,
int OneShot, int Stopping, int Paused, int Idle)

throw new Exception("The method or operation is not implemented.");

It is good habit to clean up the code during the dispose of the sheet, therefore add the
following code:

private void SheetDisposed(object sender, EventArgs e)
{

if (IsDisposed) return;

if (m_bDisposed) return;

try

{
// Add your clean up code
UnHookFromGroupAll () ;
m_GroupAll = null;
m_MyDemoSystem = null;

}

catch

{

}

m_bDisposed = true;
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Since the fundamentals are in place, we can modify the user interface to include a text label.

The label named AcqgStatus is used to show the status of the acquisition.

SheetControl.cs [Design] |

Acquisition control

o
[ Start J [ Stop } Acquisition state: | ™%

The event handler can now be programmed:

void GroupAllAcquisitionStateChanged(object sender, int Running,
int OneShot, int Stopping, int Paused, int Idle)

this.InvokeOnUI (() => DoGroupAllAcquisitionStateChanged (sender,
Running, OneShot, Stopping, Paused, Idle))
}
void DoGroupAllAcquisitionStateChanged (object sender, int Running,
int OneShot, int Stopping, int Paused, int Idle)

if (Running > 0 )

{
AcgStatus.Text = "Active";
StartCmd.Enabled = false;
StopCmd.Enabled = true;

}

else if (Paused > 0)

{
AcgStatus.Text = "Paused";
StartCmd.Enabled = true;
StopCmd.Enabled = true;

}

else if (OneShot > 0)

{
AcgStatus.Text = "Single shot mode";
StartCmd.Enabled = false;
StopCmd.Enabled = true;

}

else if (Stopping > 0)

{
AcgStatus.Text = "Stopping";
StartCmd.Enabled = false;
StopCmd.Enabled = false;

}

else if (Idle > 0)

{
AcgStatus.Text = "Idle";
StartCmd.Enabled = true;
StopCmd.Enabled = false;

}

else

{
AcgStatus.Text = "***%x",
StartCmd.Enabled = false;
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StopCmd.Enabled = false;

The event handler calls the InvokeOnUI() for support multi-threading. This function takes care
that the event request possibly coming from a background thread will be handled in the main
Ul thread. The DoGroupAllAcquisitionStateChanged() method updates the Ul: for each
state the text in the label is adapted and the command buttons are enabled/ disabled
according the possibilities each state has. E.g. when the acquisition status is active you can
only stop the acquisition, not start it.

The complete acquisition status and control handling is now event driven. Therefore we can
omit the code we introduced in the UlState property.

For initialization purposes we still can add code in the SheetControl load:

private void SheetControl_Load(object sender, EventArgs e)
{

AcgStatus.Text = "***x";

StartCmd.Enabled = false;

StopCmd.Enabled = false;

Also the key handling in the button click routines can be removed, leaving:

private void StartCmd_Click(object sender, EventArgs e)

{
// for demo purposes -> set some acquisition parameters here
// 10 kSamples at 10 kHz with trigger position at 50%

foreach (CtrlGroup myGroup in m_MyDemoSystem.Groups)
{
myGroup . SweepLength = 10000;
myGroup.TriggerPosition = 50;
myGroup . HighSamplingFrequency = 99990.0;
}
m_GroupAll.Run() ;

private void StopCmd Click(object sender, EventArgs e)

{
m_GroupAll.Stop () ;

You can of course also add a button to trigger or set the system in pause mode.

Run the software and play with the commands on the sheet as well as the command buttons of
the acquisition control in Perception.
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4.1.4

Add menu commands

As discussed earlier you can also add menu commands to allow for an improved user interface
and better keyboard support. Start with the implementation of the basic menu commands and
add an image when available:

CSI Example

P Start
B Stop

Move Sheet 'CSI Acquisition'to »

e

Once done two more things need to be done:
*  Connect the commands to the correct functions

* Add code to make the behaviour of the menu commands identical to the behaviour of the
buttons.

To connect the commands to the correct functions you need to modify the events of the
contextMenuStrip we created.

For ease of reference name the menu commands "MenuStartCmd" and "MenuStopCmd". In
the Properties dialog of the contextMenuStrip go to the Events section. In the menu select a
command and modify the Click event:

* For the MenuStartCmd select "StartCmd_Click"
* For the MenuStopCmd select "StopCmd_Click"

Now add code in the event handler and the SheetControl_Load to control the behaviour of
the menu commands, e.g.:

if (Running > 0 )

{
AcgStatus.Text = "Active";
StartCmd.Enabled = false;
StopCmd.Enabled = true;
MenuStartCmd.Enabled = false;
MenuStopCmd.Enabled = true;

You can also add a toolbar with the same functionality to finalize this chapter. When you do so
do not forget to include a call to " RebuildDynamicMenuRequested" or "ToolltemsUpdated" at
the end of the event handler to make sure that the toolbar is updated correctly.
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5.1

Hardware Settings

In the previous chapter we already have seen a small attempt to modify hardware settings. In
this chapter we will demonstrate how to access hardware settings in general and how to read
the capabilities of a specific channel and recorder. But first we will need to understand how
hardware is organized in Perception.

Hardware organization

Data acquisition hardware within Perception is based on the concept of a recorder. A recorder
consists of a number of acquisition channels that share the same basic recording parameters
sample rate, sweep length and pre- and post-trigger length. Usually a single recorder is
physically identical to a single acquisition card.

Multiple recorders can be placed in a single mainframe. The mainframe is the housing for the
recorders, provides the power and includes the interface for the local area network. A
mainframe has its own network address (IP address).

Within the Perception software recorders can be combined into logical groups for easy
reference. Recorders within a group are not bound by mainframe.

Therefore the basic ways to access hardware is either through groups or through mainframes.

There can be one or more groups. The number of groups is defined by a count. You can use
this count to index a specific group. All groups together are referenced by the GroupAll
concept.

There can be one or more mainframes. The number of mainframes is defined by a count. You
can use this count as an index to address a specific mainframe.

Each group and mainframe has one or more recorders. A recorder is part of both a group and
a mainframe.

Recorders and channels also use a count to find out how many objects are available. Use
these counts to index a specific recorder or channel.

The general method to access groups, recorders or channels is by using the foreach
statement:

foreach (CtrlGroup myGroup in m_MyDemoSystem.Groups)
1
myGroup.Sweeplength = 1088,
myGroup.TriggerPosition = 58;
myGroup.HighSamplingFrequency = 99998.8;

foreach (CtrlRecorder myRecorder in myGroup.Recorders)
1
foreach (CtrlChannel myChannel in myRecorder.Channels)
1
myChannel.InputCoupling = CtrlChannelInputCoupling.CtrlChannelIC Current;
b
¥

Here you see an actual example of accessing a specific channel setting. In this example the
group concept is used. You could, however, also loop through the mainframes:

40
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foreach (CtrlMainFrame myMainframe in m_MyDemoSystem.MainFrames)
1
foreach (CtrlRecorder myRecorder in myMainframe.Recorders)
1
foreach (CtrlChannel myChannel in myRecorder.Channels)
1
myChannel.InputCoupling = CtrlChannelInputCoupling.CtrlChannelIC_Current;
h
h

5.2 Get and set parameters
We will start with a simple example to show how to get and set the span of a channel. A
channel is a member of a recorder and every recorder is a member of the GroupAll; therefore
we can use the following line of code to get access to the first channel of the first recorder:

CtrlChannel myChannel = m_GroupAll.Recorders[l].Channels[1];

Attention: the recorder and channel collection indexes are 1 based.

5.3 Userinterface

The user interface is based on two list boxes with labels and grouped in a groupbox:

SheetControl.cs [Design]

Acquizition control

Start ] l Stop ] Acquizition state:

Span Channel 1

Span: Get

Put the following code behind the on-click events of the Get and Set buttons:

private void btnGetSpan Click (object sender, EventArgs e)
{

// Check if there are recorders available

if (m_GroupAll.Recorders.Count < 1)

{

PerceptionMessageBox.Show(this, "No Channels connected", "CSI: Demo",
MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

// Check if the first recorder contains channels
if (m_GroupAll.Recorders[l].Channels.Count < 1)
{
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PerceptionMessageBox.Show(this, "No Channels connected",
"CSI: Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

CtrlChannel myChannel = m_GroupAll.Recorders[l].Channels[1];
TextBoxSpan.Text = myChannel.Span.ToString() ;
}

private void btnSetSpan_Click (object sender, EventArgs e)
{
// Check if there are recorders available
if (m_GroupAll.Recorders.Count < 1)
{
PerceptionMessageBox.Show(this, "No Channels connected",
"CSI: Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

// Check if the first recorder contains channels
if (m_GroupAll.Recorders[1l].Channels.Count < 1)
{
PerceptionMessageBox.Show(this, "No Channels connected",
"CSI: Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

CtrlChannel myChannel = m_GroupAll.Recorders[l].Channels[1];

double dSpan = FloatingPoint.ConvertStringToDouble (TextBoxSpan.Text) ;
// Try to convert the text box string input into a double
if (double.IsNaN (dSpan))
{
string cMsg = string.Format(
"Error setting the Span of the channel: {0} to {1}",
myChannel .Name, TextBoxSpan.Text) ;
PerceptionMessageBox.Show(this, cMsg, "CSI: Demo",
MessageBoxButtons.OK, MessageBoxIcon.Error) ;
}
else
{
myChannel.Span = dSpan;
}

// Read back the Span and show it in the text box
TextBoxSpan.Text = myChannel.Span.ToString() ;

5.4 Get and set parameters using capabilities

The Perception software is based on the concept that it has no knowledge of the hardware it
therefore has to interrogate the hardware for its capabilities on a specific feature. Depending
on the feature this can be either a list of possible settings, or minimum and maximum values
including a step size.

In addition there are settings in hardware that go automatically to the nearest available value
when a different value is entered. Therefore you should always verify these settings
afterwards.

First we need to define when we can get hardware capabilities from a system. When no
hardware is available we cannot interrogate settings. When recorders are added or removed
we might need to take action. In order to do so we will "hook" onto the RecorderAdded (and
RecorderRemoved) of the GroupAll event. I.e. when somewhere in the system a recorder is
added or removed we can start interrogating its capabilities.
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5.5 Initialize

Add the following line of code in the HookToGroupAll function of our program:

" m_GroupAll.RecorderAdded += GroupAllRecorderAdded;

Add the following line of code in the UnHookFromGroupAll function of our program:

” m_GroupAll.RecorderAdded -= GroupAllRecorderAdded;

Add the following method to the program:

void GroupAllRecorderAdded (object sender, CtrlRecorder Recorder)
{

As an example we will create two drop down lists that allow us to get and set the signal and
input coupling of the first channel of the first recorder. When done you can verify correct
operation by looking at the settings sheet in Perception. In our example we will use a very
straightforward approach. In real programming life you should be more object-oriented.

5.6 User interface with Capabilities
The user interface is based on two list boxes with labels and grouped in a groupbox:

SheetControl.cs [Design]®

Acquigition contraol

Start | | Stop | Arquisition state: ==

Span Channel 1

Spar: Get
Set
(]
Settings
Signal coupling Imput coupling
A ———eo
W ’ w
(] (u}
B
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A. ComboBox for signal coupling: listSignalCoupling, with DropDownStyle set to DropDownList

B. ComboBox for input coupling: listinputCoupling, with DropDownStyle set to DropDownList

5.7 Get capabilities
You can get the capabilities of a specific settings using the GetCapabilities procedure. This
procedure requires as input the requested item and returns a structure of type Capabilities.
This structure has the following fields:
public struct Capabilities
{
public CtrlEntryType EntryType;
public object LowerBound;
public CtrlSettingType SettingsType;
public CtrlSettingUsage SettingUsage;
public object StepSize;
public object UpperBound;
public Array ValueListItems;
public Array ValueListItemsEnabled;
}
+ CtrISettingsEntryType Indicates the type of entry. E.g. CtrISettingsEntry_List indicates a
list.
*+ LowerBound Lowest value when the entry type is not a list, e.g. an edit or a list edit.
+ CtriSettingsType Defines the type of values for the upper and lower values, e.g. a
CtrISettingsType_14 indicates a four-byte integer.
+ CtrlSettingsUsage Are you allowed to modify it? E.g. CtrlSettingsUsage_Selectable
indicates yes.
+ StepSize Stepsize when entry type is a step edit.
+ UpperBound Highest value when the entry type is not a list, e.g. an edit or a list edit.
* ValueListltems When entry type is a list, these are the possible 'values'.
* ValueListltemsEnabled For each list entry there is a value that indicates if a value is
enabled or not, or only when acquisition is idle.
In the RecorderAdded event handler a possible scenario could be as follows:
243 | void GroupAllRecorderAdded (object sender, CtrlRecorder Recorder)
244 | {
// Make user interface update thread safe by using InvokeOnUI ()
245 this.InvokeOnUI (() => DoGroupAllRecorderAdded (sender, Recorder)) ;
246 |}
248 | void DoGroupAllRecorderAdded (object sender, CtrlRecorder Recorder)
249 | {
250 // this should be > 0, but you never know
251 if (m_GroupAll.Recorders.Count == 0)
252 return;
253
254 // now we have at least one recorder, but does it have channels?
255 if (m_GroupAll.Recorders[1l].Channels.Count == 0)

44

A2698_05_E00_00 HBM: public



I
o
<4

CSI Programming and user manual

256
257
258
259
260
261
262
263
264
265
266
267
268
269

271
272
273
274
275
276
277
278
279
280
281
282
283
284
285

286
287

288
289
291
292
293
294
295
296
297
298
299

300
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304
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308
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310
311
312
313
314
315
316
317

return;

// did we already £fill this list?
if (listSignalCoupling.Items.Count > 0)
return;

// Create variables
CtrlChannelSignalCoupling CCSC;
CtrlChannellInputCoupling CCIC;
string sResult;

// fetch signal coupling capabilities

Capabilities args;

m_GroupAll.Recorders[l] .Channels[1l].GetCapabilities (
CtrlChannelCapabilities.CtrlChannelCaps_SignalCoupling, out args);

// are we allowed to use this setting?
if (args.SettingUsage != CtrlsSettingUsage.CtrlSettingUsage_Selectable)
return;

// is it a list?
if (args.EntryType == CtrlEntryType.CtrlEntryType List)
{
// yes to all -> fetch values that we are allowed to use
listSignalCoupling.Enabled = true;
int vILB = args.ValuelListItems.GetLowerBound(0) ;
int vUB = args.ValuelListItems.GetUpperBound(0) ;
for (int nItem = vLB; nItem <= vUB; nItem++)
{
CCsC =
(CtrlChannelSignalCoupling)args.ValuelistItems.GetValue (nItem) ;

if (CtrlEntryEnabled.CtrlEntryEnabled Never ==
(CtrlEntryEnabled) args.ValueListItemsEnabled.GetValue (nItem))
continue;

sResult = GetEnumSigConString (CCSC) ;

listSignalCoupling.Items.Add (Item) ;
}
// fetch the actual setting
CCSC = m_GroupAll.Recorders[1l].Channels[1l].SignalCoupling;
sResult = GetEnumSigConString (CCSC) ;
// show actual setting
listSignalCoupling.SelectedIndex =
listSignalCoupling.FindStringExact (sResult) ;

// continue with second list if not already done
if (listInputCoupling.Items.Count == 0)
{
// fetch input coupling capabilities
m_GroupAll.Recorders[l] .Channels[1l].GetCapabilities (
CtrlChannelCapabilities.CtrlChannelCaps_InputCoupling, out args);

// are we allowed to use this setting?
if (args.SettingUsage != CtrlsSettingUsage.CtrlSettingUsage_ Selectable)
return;

// is it a list?

if (args.EntryType == CtrlEntryType.CtrlEntryType List)

{
// yes to all -> fetch values that we are allowed to use
listInputCoupling.Enabled = true;
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318 int vILB = args.ValuelistItems.GetLowerBound(O0) ;
319 int vUB = args.ValuelistItems.GetUpperBound(0) ;
320 for (int nItem = vLB; nItem <= vUB; nItem++)
321 {
322 CCIC =
(CtrlChannelInputCoupling)args.ValuelListItems.GetValue (nItem) ;
323
324 if (CtrlEntryEnabled.CtrlEntryEnabled Never ==
(CtrlEntryEnabled) args.ValuelListItemsEnabled.GetValue (nItem))
325 continue;
326
327 sResult = GetEnumInpConString (CCIC) ;
328
329 listInputCoupling.Items.Add (Item) ;
330 }
331 // fetch the actual setting
332 CCIC = m _GroupAll.Recorders[1l].Channels[1l].InputCoupling;
333 sResult = GetEnumInpConString (CCIC) ;
334 // show actual setting
335 listInputCoupling.SelectedIndex =
listInputCoupling.FindStringExact (sResult) ;
336 }
337 }
338 |}

In the above example we fill the signal and input coupling lists. The code is not optimized for
demonstration purposes.

Inlines 243 - 246 we do our multi-threading support by calling the InvokeOnUI() function

The actual event handler starts with some tests: are recorders added (line 250 - 256), if so,
are there any channels available in the first recorder (line 255 - 256)7?

Since this event probably is called multiple times (each recorder added fires this event), we
must check one way or another if we already have filled the list or not. Here a test is done to
verify if the list is filled in line 259 - 260.

The lines 263 - 269 are used to declare and initialize variables we need in the rest of the code.

In line 269 we make the actual call to the procedure that provides us with information about
the signal coupling capabilities of the selected channel of the selected recorder.

Now we need to investigate these settings: line 273 - 274 verifies if we are allowed to use this
setting or not.

We continue if it is a list (line 277).

There are two arrays provided: ValueListltems, a list of values and ValueListltemsEnabled,
a list of corresponding settings. For each entry in ValueListltems there is an entry in
ValueListltemsEnabled that defines the behaviour of the value in ValueListltems.

In line 283 - 295 we step through the ValueListltems and the ValueListltemsEnabled. For each
ValueListltems item that we may use we add an entry in the signal coupling list. The entry in
the list is a string. Therefore we make use of a procedure that converts the enumeration into
an actual string.

Visual studio can provide a helping hand in the creation of such a procedure. The result can
look like this:
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529
530

private string GetEnumSigConString(CtrlChannelSignalCoupling sc)

{

switch (sc)

{

}

case CtrlChannelSignalCoupling.

return "AC";

case CtrlChannelSignalCoupling.

return "AC-External";
case CtrlChannelSignalCoupling
return "AC-Freq";

case CtrlChannelSignalCoupling.

return "AC-RMS";

case CtrlChannelSignalCoupling.

return "AC-TrueRMS";
case CtrlChannelSignalCoupling
return "DC";

case CtrlChannelSignalCoupling.

return "DC-External";

case CtrlChannelSignalCoupling.

return "DC-Freq";

case CtrlChannelSignalCoupling.

return "DC-RMS";

case CtrlChannelSignalCoupling.

return "DC-TrueRMS";

case CtrlChannelSignalCoupling.

return "GND";
default:
return "----";

return "**k*" .

CtrlChannelSC_AC:
CtrlChannelSC_AC ExternalProbe:
.CtrlChannelSC_AC Frequency:
CtrlChannelSC_AC RMS:
CtrlChannelSC_AC TrueRMS:
.CtrlChannelSC_DC:
CtrlChannelSC_DC_ExternalProbe:
CtrlChannelSC_DC_Frequency:
CtrlChannelSC_DC_RMS:
CtrlChannelSC_DC_TrueRMS:

CtrlChannelSC_GND:

When the list is filled, the last thing we need to do is to find out the actual setting and show it.
To do this we get the signal coupling property, convert it again to a string and use this as a
pointer to set the index of our list. Below is an example of the user interface when the code is

executed.

In lines 305 — 335 the input coupling list will be filed using similar steps.
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Acquizition contral
Acquizition state:  1dle

Span Channel 1

Sparn: |10 et
Set

Settings
Signal coupling Input coupling
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A
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Items are added to the list when the corresponding setting is not equal to
CtrlEntryEnabled_Never (line 324). However, some items can only be enabled when
acquisition is idle. This means that they are in the list by default but should be 'disabled' when
acquisition is not idle. We will discuss this issue in the next section where we will show you
how to send a setting to the hardware.

5.8 Modify a hardware setting
As mentioned in the previous section, some hardware settings are only allowed when
acquisition is idle. However, after we have used a GetCapabilities function, this information is

lost, unless we save this information.

One way to save this information is to create a class that contains all this information. We will
do this for our signal coupling and input coupling items.
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5.9

Create a class

To create a class in Visual Studio select Project > Add Class ... and add a class named
Comboltem.

Class View «+ 1 X

Cy | o= RN oY

<Search> v LJ

| =-(5f] CSI_Acquisition
[+ Project References
{} CSI_Acquisition
B4 Comboltem|
#-“1% SheetControl
#-“1% SheetControllnfoProvider
{} CSI_Acquisition.Properties

1]

[+

Go to the class view to see classes.

Initially this class should have the following code:

O oo Jo WD K

B R R R R
& WN KR o

15
16
17
18
19
20
21
22
23
24
25

using System;

using System.Collections.Generic;
using System.Text;

using Perception.ILO.Engine;

namespace CSI_Acquisition
{
class ComboItem
{
public string m_Text;
public int m Value;
public CtrlEntryEnabled m _Enabled;

public ComboItem(string Text, int Value, CtrlEntryEnabled
Enabled)

m_Text = Text;
m_Value = Value;
m_Enabled = Enabled;
}
public override string ToString()

{

return m Text;

This code creates three public class members: one for the string that we use in our list, one for
the enumerator and one for the '‘enabled'-value.

The constructor fills these members with the values it gets.

The ToString() method returns the string.
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Now we also need to adjust the code from the previous section a little bit. Once an item was
found that could be added to the list we had the following code:

sResult = GetEnumSigConString (CCSC) ;
listSignalCoupling.Items.Add (sResult) ;

Now we also have to create the new object:
sResult = GetEnumInpConString (CCIC) ;

ComboItem Item = new ComboItem(sResult, (int) CCIC,
(CtrlEntryEnabled) args.ValuelistItemsEnabled.GetValue (nItem));

listInputCoupling.Items.Add (Item) ;

The line where we show the actual setting should read:

listSignalCoupling.SelectedIndex = listSignalCoupling.
FindStringExact (sResult) ;

We need to do this because an object is added to the list, not a text string. So far operation of
our drop-down lists will remain the same.

We repeat this also for the second list the signal input coupling:

sResult = GetEnumSigConString (CCSC) ;
listSignalCoupling.Items.Add (sResult) ;

Now we also have to create the new object:
sResult = GetEnumInpConString (CCIC) ;

ComboItem Item = new ComboItem(sResult, (int) CCIC,
(CtrlEntryEnabled) args.ValuelistItemsEnabled.GetValue (nItem)) ;

listInputCoupling.Items.Add (Item) ;

5.9.1 Modify the setting
Madification of the actual hardware setting is simple. However, we need to keep in mind that
we cannot change every setting always. Therefore additional code is required. We will react on
the SelectionChangeCommitted event of the list. This event is generated when "an item is
chosen from the drop-down list and the drop-down list is closed".

Here we need to verify if the selected option is allowed and, if so, modify the hardware setting.

Initially we will start with the following code:
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617 private void listSignalCoupling_ SelectionChangeCommitted (
object sender, EventArgs e)
618 {
619 ComboItem Item = listSignalCoupling.SelectedItem as ComboItem;
620
621 if (Item.m Enabled == CtrlEntryEnabled.CtrlEntryEnabled WhenIdle)
622 {
623 // Check acquisition status
624 int Live;
625 int Pause;
626 int HoldNext;
627 int HoldLast;
628 int Idle;
629
630 m_GroupAll.GetAcquisitionState (out Live, out HoldNext,
out HoldLast, out Pause, out Idle);
631 if (Idle '= m_GroupAll.Recorders.Count)
632 {
633 listSignalCoupling.SelectedText = GetEnumSigConString
(m_GroupAll.Recorders[1l].Channels[1].SignalCoupling) ;
634 return;
635 }
636 }
637 m_GroupAll.Recorders[1l] .Channels[1].SignalCoupling =
(CtrlChannelSignalCoupling) Item.m Value;
638 }

Since we are working with Comboltem objects we first need to define a new object for this
routine and at the same time copy the selected object values into it (line 302).

In line 621 verify the enabled setting. If this setting is enabled when idle we need to test,
otherwise it is ok

Note: only items that are enabled are in the list
Check the acquisition status. When the acquisition status is not idle replace the selected item
text with the text that represents the actual current situation, do nothing and return.
Otherwise send the new setting.
This should do the job.

When you are using the Genesis Firmware Simulator, or depending on your actual hardware,
you might see another phenomenon:

Depending on the acquisition state the capabilities displayed in the settings sheet differ from
the capabilities we have seen so far.

This is because some capabilities are listed differently when the system is idle or not.

To cope with this issue we should have written our code better structured to make it easier to
respond to various events, e.g. the m_GroupAll.Recorders[1].CapabilitiesChanged() event.

For the time being we will solve this issue with a 'trick’: when our list drops down, we clear the
list and fill it again. To fill it we call the RecorderAdded event handler, because there is where
our code is:
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private void listSignalCoupling DropDown (object sender, EventArgs e)

{
listSignalCoupling.Items.Clear() ;

m_GroupAll RecorderAdded(null) ;

When using the Genesis Firmware Simulator you can see these effects. First make sure you
are idle and display the list:

Acguizition control
Acquizition state:  1dle

Span Channel 1

Span: |10 | Get

Settings

Signal coupling [nput coupling

DT v| |SEPosiive v

AC-Euternal
DC-Extermnal

Here you will see 5 items, the last two are only available when the system is idle.

Now start an acquisition.

Acquizition control

Stop Acquisition state:  Active

Span Channel 1

Span: |10 | [T]
Set
Sethngs
Signal coupling Input coupling
DC w |SE Positive
GD

OC

And display the list: only the top 3 items are available.
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Now there is only one thing remaining: full synchronization between our sheet and Perception.
When we modify a setting, this is reflected in the Perception software. However, when
Perception modifies a setting, this is not reflected in our sheet. So we need another event
handler.

5.10 Synchronization

We need to get notified when a setting has changed and react on this event. For this we need
to create an object for a channel that generates events when something has changed. As a
rule of thumb: create an object for each 'unit' that you want to modify. E.qg. if you want to modify
channel settings, create a channel object. This object then has properties, methods and events
that we can use.

Example: create a channel member variable in the Members region:
#region -> MyMembers
private CtrlAcquisitionSystem m MyDemoSystem = null;

private CtrlGroup m_GroupAll = null;
private CtrlChannel m_Channel = null;

#endregion

Before we can use this member variable we need to initialize it. This can be done the first time
we access the channel setting: in the RecorderAdded event handler, just before we fetch the
signal coupling capabilities.

// Connect the object and hook it to the correct event
if (m_Channel == null)
{
m_Channel = m_GroupAll.Recorders[1l].Channels[1];
m_Channel.ScCouplingSettingsChanged +=
m_Channel_ScCouplingSettingsChanged;

First we check if the object is already initialized, if not it is connected to the first channel of the
first recorder and a corresponding event handler is defined.

The event handler itself can have the following code:
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371
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374

375
376
377
378
379

380
381
382
383
384
385
386
387
388
389
390
391
392
393

void DoChannelScCouplingSettingsChanged (object Sender,
CtrlCouplingSettingItem Mask, CtrlChannelInputCoupling InCoupling,
CtrlChannelSignalCoupling SigCoupling, double MeasuringPeriod, double
Referencelevel, double Impedance, double InputCapacityLow, double
InputCapacityHigh)

{

InputCapacityHigh)) ;
}

void DoChannelScCouplingSettingsChanged (object Sender,
CtrlCouplingSettingItem Mask, CtrlChannelInputCoupling InCoupling,
CtrlChannelSignalCoupling SigCoupling, double MeasuringPeriod, double
Referencelevel, double Impedance, double InputCapacityLow, double
InputCapacityHigh)
{

// event handler. we only do the signal coupling changed here

// although we could also do the input coupling here

if (Mask !'= CtrlCouplingSettingItem.CtrlCouplingSettingItem
SignalCoupling)
return;

string sResult = GetEnumSigConString(SigCoupling) ;
int scIndex = listSignalCoupling.FindStringExact (sResult) ;
if (scIndex < 0)
{
// item could not be found -> list is incorrect
// so rebuild and reset index
listSignalCoupling.Items.Clear () ;
m_GroupAll RecorderAdded (null) ;
scIndex = listSignalCoupling.FindStringExact (sResult);
}
listSignalCoupling.SelectedIndex = scIndex;

this.InvokeOnUI (() => DoChannelScCouplingChanged (sender, Mask, InCoupling,
SigCoupling, MeasuringPeriod, Referencelevel, Impedance, InputCapacityLow,

As a starter: Use the InvokeOnUI() to for the multi-threading support.

After this we check which parameter fired this changed event. To keep it simple we only test

for the signal coupling: when it is not the signal coupling we return (line 382).

As we have done earlier we fetch the text string that corresponds to the enumeration and find

the index in the list that corresponds to this text.

Now we stumble into a typical behaviour. As mentioned earlier, capabilities can change

depending on the acquisition state. This is what we try to catch in lines 384 - 391: if we cannot
find the correct string, the index returns -1 and therefore we need to rebuild the list with a trick
as we have done before. Should we have dealt with this situation better in the first place, then

this would have not been necessary.

As an example remove the test and proceed as follows with the Genesis Firmware Simulator

‘connected”:
+ Make sure that the system is idle.
+ Set the signal coupling to 'external’

+ Start an acquisition.

54
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*  The drop-down list will now only show the two 'external’ options.
»  Stop the acquisition and switch to AC, DC, or GND in the settings sheet.
» The text entry field in 'our' list will be empty.

»  Drop down the list and the list will be initialized by the drop-down event handler of the
combo-box.

If you have the multiple workbook option in Perception and a dual-monitor system you can do
your testing more easily: move the test sheet to a new workbook and place this on the second
monitor. Now you can have both sheets active: the settings sheet and the test sheet and verify
the correct interaction.
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6.1

Data Visualization

Data acquisition is all about data: the acquisition, display, analysis, reporting and archiving of
data. So far we have been occupied with sheet interfacing, acquisition control and modifying
settings. So now it is time to do some visualization of recorded data and basic measurements
within that data. Using the Perception CSI has the advantage that you have access to a variety
of functions that you do not need to program yourself. One of them is the data display.

Note that when you use an "off-the-shelf' Perception component you also get all the additional
stuff for free. E.g. the display also gives you zooming, cursors, measurements, drag-and-drop,
etc.

Data display

The data display is part of a range of standard Perception components that can be added to
your project. In the past (32-bit version of Perception) you could directly use the Perception
Display component in the Visual Studio designer of your CSI project. However for the 64-bit
version of Perception this is not possible anymore because Visual Studio is 32 bit and does not
support 64-bit native code components in design mode. The Perception Display and Meter
core is build using native code. To solve this problem there are two wrapper components
added to Perception called PerceptionDisplay and PerceptionMeter, these components are
in Perception.CSI.Support.dll. They do not show the meter or display in the visual studio
designer but show a blue or green area with a yellow text like you see in the picture below.

Perception C5l Sheet1® SheetControl.cs [Design] @ + X _

Perception Meter
myPerceptionMeter

Perception Display

myPerception Display

(]
[

During runtime this looks like:

56
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| Example Sheet

'erception Meter *

myPerceptionDisplay *

Fage 1 = *) || (* |

To add the Perception components
1. Go to the SheetControl Design layout.
2. Inthe Toolbox select one of the tab headers and do a right mouse click.

3. Inthe context menu that comes up select Add Tab and give it a relevant name like
"Perception Components".

4. With this tab selected do a right mouse click.

5. Inthe context menu that come up select Choose Items ...

6. Inthe dialog that comes up select Browse...

7. Navigate to the Perception folder. Typically: C:\Program Files\HBM\Perception.
8. Select the file Perception.Components.dll and click Open.

9. Click OK in the Choose Toolbox Items dialog.

Now the components are added to the toolbox.

To add the Perception wrapper components
1. Go to the SheetControl Design layout.
2. Inthe Toolbox select one of the tab headers and do a right mouse click.

3. Inthe context menu that comes up select Add Tab and give it a relevant name like
"Perception CSI Support".
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6.1.1

4.

5.

6.

7.

8.

9.

With this tab selected do a right mouse click.

In the context menu that come up select Choose ltems ...

In the dialog that comes up select Browse...

Navigate to the Perception folder. Typically: C:\Program Files\HBM\Perception.
Select the file Perception.CSI.Support.dll and click Open.

Click OK in the Choose Toolbox Items dialog.

Now the components PerceptionDisplay and PerceptionMeter are added to the toolbox.

User interface

The user interface for this example is simple: a display and a command button. The command
button is used to fill' the display with data sources.

When combined with our previous example the layout could look like this:

Shectcontrocs Desgnl =

Acquistion control

Start Stop Acquisition state:  ****

Span Channel 1

Set
Settings
Signal coupling Input coupling
~ v
Display
@ Fill Display

6.1.2

B
A. Command button FillCmd
B. Placeholder for the data display display1
The code

To gain access to the data sources for display we need to have access to the data manager.
The data manager is the central part of the software that manages all data: waveforms

58
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(analogue, digital), numerical values, system variables, etc. So we will start with the obvious:
#region -> MyMembers

private CtrlAcquisitionSystem m MyDemoSystem = null;
private CtrlGroup m_GroupAll = null;

private CtrlChannel m Channel = null;

private DataManager m DataManager = null;

#endregion

All the required code is placed within the FillCmd_Click routine as follows:

712 private void FillCmd Click (object sender, EventArgs e)
713 {
714 if (m_DataManager == null)
715 {
716 m_DataManager = new DataManager();
717 }
718 // clear display
719 for (int j = displayl.pDisplay.TimeDisplay.CtlLayout.Pages.Count;
j >0:;3--)
720 {
721 displayl.pDisplay.TimeDisplay.CtlLayout.Pages[j] .Delete() ;
722 }
723 displayl.pDisplay.TimeDisplay.Pages.InitPages() ;
724
725 int TraceCount = 1;
726 foreach (PoolEntry PE in m_DataManager.PoolEntries)
727 {
728 if (PE.DataSource == null)
729 continue;
730 if (PE.DataSource.DataType !=
RecordingInterface.DataSourceDataType.
731 DataSourceDataType AnalogWaveform)
732 continue;
733 string[] aPoolEntry = new string[] { PE.Name };
734 if (TraceCount > 4)
735 {
736 displayl.pDisplay.TimeDisplay.AddPage () .Activate() ;
737 TraceCount = 1;
738 }
739 else
740 {
741 if (TraceCount != 1)
742 {
displayl.pDisplay.TimeDisplay.CtlLayout.Pages.
743 ActivePage.Panes.AddPane () .Activate() ;
744 }
745 }
746 displayl.pDisplay.AddDataSources (aPoolEntry) ;
747 TraceCount++;
748 }
749 displayl.pDisplay.TimeDisplay.CtlLayout.Pages[1l] .Activate() ;
}

We start with some housekeeping:
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* 714 -717: Create a new data manager object.

* 719 - 722: Delete all pages that exist.

» 723: Create a single new page and make it the active page.

The main loop is used to step through all available data sources (pool entries). When an
analogue waveform is found this waveform is added to the display. In this example we use a
maximum of 4 traces per page, each trace in its own pane.

» 728 - 731: Skip empty data sources and all data sources that are not analogue waveforms.

» 732: Astring array is created (with only one entry) that contains the identifier of an
analogue waveform.

» 733 -736: Create a new page when number of traces on this page exceeds 4 and activate
it.

+ 738-743: Add a new pane for a trace when it is not the first trace of a page and activate it.

« 745 -746: Add the data source to the display on the active page in the active pane.
Increment the trace counter.

When all is said and done activate the first page to show it.

Now run the code.

Aequizition contral

Stop Acquizition state:  Active

Span Channel 1

Spar: (10 O 5| 0 -ooov| I saomo
Set ] el
Settings _ -
Signal coupling Input coupling
(o] ¥ SE Positive %
Dizplay 1000 Y

Fill Dizplay

000’ 10,00 ms/div

[Pase 8 BRI OQCIRSE

Note: that the display is fully integrated in the Perception software: you can zoom and
pan, modify the properties, drag and drop data sources from the navigator into the
display, do cursor measurements, etc.

For better performance when looking for pool entries we recommend the use of the
PoolEntries function GetNames(). This function returns an array of pool entry strings. As an
input parameter you enter a string to define where to look in the pool, you can use the “*”
character as a wildcard. The second parameter defines the type of the pool entry you want.
The last parameter gives you back an array containing the found pool entries.
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Code example:

Array aNames;
m_DataManager.PoolEntries.GetNames ("Active.*",
PoolEntryType.PoolEntryType Waveform, out aNames) ;

foreach (string cName in aNames)
{

string[] aPoolEntry = new string[] { cName };

if (TraceCount > 4)

{
displayl.pDisplay.TimeDisplay.AddPage () .Activate() ;
TraceCount = 1;

}

else

{
if (TraceCount != 1)

{
displayl.pDisplay.TimeDisplay.CtlLayout.
Pages.ActivePage.Panes.AddPane () .Activate() ;
}

}
displayl.pDisplay.AddDataSources (aPoolEntry) ;
TraceCount++;

6.2 Meter

As standard the 'digital' meter is accessible. You can add a numerical meter the same way as
a display. In the next example we will add a meter and 'connect' it to the measurement cursor
Y-value. At the same time we will 'hook’ to the event when the measurement cursor value
changes and modify a text label to show the corresponding X-value.

6.2.1 User interface

The user interface consists of a meter and a text label. We need to make a little bit more room
to make everything fit.
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SheetControl.cs [Design] & X
Acquisition control
Start Stop Acquisttion state:

Span Channel 1

Span: I:I Get

Set
Settings
Signal coupling Input coupling
~ A
Display Pereoion s
® 'erceptionDisplay
A Display
Fill Display t (sec):
B E PerceptionMeter

Meter

A. Text label XValueLbl

B. Placeholder for meter meterl
6.2.2 Thecode

As a starter add a new member:

“private PoolEntry m_ActiveCursor = null;

Modify the SheetControl_Load to include some initialization. By now it could look like this:

561 private void SheetControl Load(object sender, EventArgs e)

562 {

563 AcqgStatus.Text = "**x*",

564 StartCmd.Enabled = false;

565 StopCmd.Enabled = false;

566 FillCmd.Enabled = false;

567 MenuStartCmd.Enabled = false; ToolStartCmd.Enabled = false;

568 MenuStopCmd.Enabled = false; ToolStopCmd.Enabled = false;

569 listSignalCoupling.Enabled = false;

570 listInputCoupling.Enabled = false;

571 displayl.UserName = "CSIDisplay";

572 // set meter name ans connect meter to the correct pool entry

573 meterl.UserName = "CSIMeter";

574 string[] aPoolEntry = new string[] { "Display.CSIDisplay.
ActiveCursor.YValue" };

575 meterl.pMeter.LDSMeter.AddDataSources (aPoolEntry) ;

576 }
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The new information starts at line 571.

In lines 571 and 572 the name of the display and the meter are set. It is imperative that you
use unique names throughout the Perception application, otherwise the navigators cannot
make a distinction and use the first available object only.

Inlines 573 and 574 the data source is 'connected' to the display in the same way as you
would connect to a display.

Again we want to connect to an event. Therefore we need to create an event handler. At the
same time move some code to a better location.

We will start using the constructor section:

57 public SheetControl ()
58 {
59 InitializeComponent () ;
60
61 if (m_DataManager == null)
62 {
63 m_DataManager = new DataManager();
64 }
65
66 if (m_DataManager != null)
67 {
68 m_ActiveCursor = m _DataManager.PoolEntries|[
"Display.CSIDisplay.ActiveCursor.XPosition"];
69 }
70
71 HookToActiveCursor () ;
72 Disposed += SheetDisposed;
}

Line 61 - 64 is the moved code.

In line 66 - 69 a new member is created: the x-position of the active cursor of our named
display.

Inline 71 hook to the active cursor changed event.
Note that you need to create an event handler for each object that you want to use this way.

Also note that a pool entry with a name (line 68) always returns an object. This allows us to
hook to events even before the actual variable is initialized.

private void HookToActiveCursor ()
{
UnHookFromActiveCursor () ;
if (m_ActiveCursor != null)
{
m_ActiveCursor.DataChanged += ActiveCursor_DataChanged;

}
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private void UnHookFromActiveCursor ()

{

if (m_ActiveCursor != null)

{

m_ActiveCursor.DataChanged -= ActiveCursor_DataChanged;

}

Our last action for this example is to create the corresponding event handler:

796 void ActiveCursor_DataChanged()
797 {
798 this.InvokeOnUI ( ()=>
799 {
800 if (m_ActiveCursor != null)
{
801 double dXVal = (double) m_ActiveCursor.DataSource.Value;
802 XValuelbl.Text = dXVal.ToString ("##0.000") ;
803 }
804 }
805 }

Of course we start with thelnvokeOnUI() to make it possible to update the Ul from a possible
call coming from a sub thread

In line 801 the actual value is fetched. Since an object is returned we need to convert it to a
double before we can format the output. If no formatting was required we could have used the
one-liner:

“XValueLbl.Text = m_ActiveCursor.DataSource.Value.ToString() ;

Do not forget to call the UnhookFromActiveCursor() in the SheetDisposed method.
Also set the private member variable m_ActiveCursor to null in the SheetDisposed method.

Run the code to see it in action.
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The meter shows the Y-value of the active trace at the position of the active (red)
measurement cursor. The text label shows the X-position. Moving the cursor will update the

values. Also selecting another trace will update the values.
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7 Data Analysis - Part One

After discussing acquisition and visualization in the previous chapters it is now time to start
working on the analysis of data. This topic is so extensive that we split it into two parts. In this
first part we will describe the concepts of the data manager, data sources and user variables.
In our examples we will demonstrate how you can use the measurement cursors to define a
part of interest within a waveform, cut out that part of a waveform, do some basic operation on
this data and put it back into the system and display it. We also will show how to use the
internal Perception calculators to do some basic calculations on data. Display markers will be
used to show the calculation results into a display.

7.1 Introduction

In this first part we will give an introduction on relevant concepts: data manager, data source
and user variables.

7.2 The data manager

In previous chapters and examples we already have seen the data manager. The data
manager was defined as:

protected DataManager m_DataManager = null;

if (m_DataManager == null)
{

m_DataManager = new DataManager();

}

The data manager is the central part of the software that manages all data: waveforms
(analog, digital), numerical values, system variables, etc.

To do so the data manager:
+ keeps a list of ALL variables available in the system,
* maintains a list of event listeners for each variable,

+ takes care of creating the link between data originators (data sources) and data
consumers

Variables within the system:

» are of a specific type:
o number
o string (literal text)
o waveform analog or digital
o formula, i.e. the result of a calculation through the formula database,
o etc.
* have a unique name, e.g.:

o System.Constants.Pi
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7.2.1

o Active.Groupl.Recorder A.Ch_Al
* have areference to their data source (the IDataSrc interface)

* have a list of event subscribers. Events can be:

o data added

o data changed

o etc.
All variables are controlled by the data manager and stored in the data pool. To gain access
to a variable you need to fetch the variable out of the data pool through the data manager, i.e.
you request from the data manager an entry out of the datapool, the pool entry. Using the
aforementioned definition:

PoolEntry PE = m DataManager.PoolEntries["System.Time"];

if (PE.EntryType == PoolEntryType.PoolEntryType String)
{
}

Note that PoolEntries[<name>] always returns a PoolEntry object. This allows you to hook to
events even before the variable is initialized.

At this point you have the pool entry, i.e. the gateway to the actual data source, but not yet the
data itself!

For this we need to go one step further: the IDataSrc interface. This interface is the most
important interface in Perception. It is the interface between the data originator and data
consumer.

Typical data sources include numerical, string and waveform data sources.

Numerical data source

For the numerical data source the following 'settings' are in effect (there are more):

+ Type = DataSourceDataType_Numerical

* Name is the user name of the variable, e.g. "Mean"

* Value is the actual value, returned as an object

* YUnits contains the technical unit string for this value
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As an example have a look at the following code:

using RecordingInterface;

PoolEntry PE =
m_DataManager.PoolEntries["Display.CSIDisplay.ActiveCursor.Yvalue"];
if (PE.EntryType == PoolEntryType.PoolEntryType Number)
{
if (PE.DataSource.DataType == DataSourceDataType.
DataSourceDataType Numerical)
{
if (PE.DataSource.Value != null)
{
double dvValue = (double)PE.DataSource.Value;
string sUnits = PE.DataSource.YUnit.ToString()
string sName = PE.DataSource.Name.ToString() ;

The result can be:
+ dValue =-0.31596969696967947
* sUnits ="Volt"
+ sName = "Active Cursor YValue"
First we test the pool entry type. Then we test the actual data source type. Usually these are
the same. However, there are situations with waveforms where the pool entry type returns an
analogue waveform, while the data source type returns a more detailed description.
As mentioned the value itself is an object. When null it does not exist. In our example the
active cursor could be outside the waveform range and return null. The value could also return
an invalid number (NaN).

7.2.2 String data source
For the string data source the following 'settings' are in effect:
+ Type = DataSourceDataType_String

* Name is the user name of the variable, e.g. "Local Time"

* Value is the actual string value, returned as an object

68 A2698_05_E00_00 HBM: public



I

CSI Programming and user manual

Example:

7.2.3

7.3

PoolEntry PE = m DataManager.PoolEntries["System.Time"];
if (PE.EntryType == PoolEntryType.PoolEntryType String)
{
if (PE.DataSource.DataType == DataSourceDataType.
DataSourceDataType_ String)
{
if (PE.DataSource.Value '= null)

{
PE.DataSource.Value.ToString() ;

string sTime
string sName = PE.DataSource.Name.ToString() ;

The result can be:
e sTime ="11:55:50"
« sName = "Local Time"

In the above example the same procedure is followed as in the numerical data source
example.

Waveform data source

Waveforms are more complex than the relatively simple numerical and string data sources.
Important parameters / settings are:

e Status:
o Static: the data has been recorded. No new data will be added to this waveform.

o Dynamic: data is being recorded and DataAdded events will be fired.

* Sweeps: a collection of DataSweep objects that can be used to determine start and end
times of sweeps in multi-sweep acquisitions.

+ GetValueAtTime: a method to get a value at a specified time - even if that time is between
two consecutive samples - using linear interpolation.

An important feature of waveforms is that they consist of one or more segments. When you
retrieve the data, you will get initially a list of segments. Each segment is a piece of data with
its own X- and Y- information as well as begin and end time. Data may be segmented due to
timebase changes as well as amplifier range changes. Also gaps (e.g. caused by a temporarily
pause of the acquisition) create segments.

For more detailed information on recordings, segments, etc. refer to the HBM PNRF SDK
User Manual that is separately available.

User data sources

As opposed to the data sources described earlier there are also user variables. These user
variables form a single collection of user data sources.
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7.3.1

The user data sources are created and modified by the user, i.e. for specific types of variables
the user can define its own content. You cannot do this with standard data sources, e.g. you
cannot modify the value of string or the value of a cursor position or the contents of waveform.

Three types of user data sources can be created:
*  Numerical data

+  String data

+  Waveform data

In order to create a user data source you will need to add a reference to the
Perception.UserVariables.

To add the Perception UserVariables reference
1. Goto Project > Add Reference...
2. Inthe dialog that comes up select Browse...
3. Navigate to the Perception folder. Typically C:\Program Files\HBM\Perception.
4. Select the file Perception.UserVariables.dll and click OK.
Now the reference is added.
Add a using statement as follows:
"using Perception.UserVariables; "
User numerical data source
The user numerical data source requires two parameters to be created:
* Path name
* User name
Once created it has multiple properties, e.g.:
*  Numerical value
*  Units string
To create a user numerical data source see the following code:

NumericalDataSource MyNum;
UserDataSources MySources = UserDataSources.Instance;

MyNum = MySources.CreateNumber ("CSIDemo.MyNumber", "CSI Numerical") ;

MyNum.Value = 10;
MyNum.Units = "Volt";

This code will create a user numerical data source and the required collection.

You can find the your newly created variable in the data sources navigator.
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Data Sources o X
+ Active
Y23 MyNumber
B2 MyResult
The variable has been created with the name MyNumber in the branch CSIDemo.
7.3.2 User string data source
Very much the same as we created a user numerical variable, we can create a user string
variable. Assuming we already have created an instance of the UserDataSources collection:
StringDataSource MyString;
MyString = MySources.CreateString("CSIDemo.UserData.MyString", "CSI
String") ;
MyString.Value = "Hello World";
Here we also have expanded the navigator tree.
Data Sources o x
(=] Active
o MyString
Display
Formula
=7] Perception_Demo_File_1
System
When you modify the variable name string from the user numerical value also gives you the
above result.
7.3.3 User waveform data source

More complex is the user waveform data source.

The main parameters include:

« Name

*  Both horizontal and vertical units

» Display range

+ The use of blocks: a waveform is composed of blocks, each block with his own start time,
X-Step value (sample rate) and number of samples.
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Have a look at the following code, assuming we already have created an instance of the
UserDataSources collection:

WaveformDataSource MyWaveData;
WaveformDataBlock WfBlock;

// £ill a buffer with a double sinewave
// array is zero-based
double[] Buffer = new double[720];
double angle;
for (int i = 1; i <= 720; i++)
{
angle = i * (Math.PI / 180);
Buffer[i-1l] = (double) (5 * Math.Sin(angle))

// create the waveform
MyWaveData = MySources.CreateWaveForm("CSIDemo.UserData.MyWave",

"SineWave") ;

// set display range and units
MyWaveData.DisplayRangeFrom = 8;

MyWaveData.DisplayRangeTo = -8;
MyWaveData.YUnits = "Volt";
MyWaveData.XUnits = "s"

// add the data block and fill with buffer data

// data starts at t=0 and uses an XStep of 0.001 s
WfBlock = MyWaveData.AddDataBlock (0, 0.001) ;
WEfBlock.WriteWaveform (0, Buffer);

Start with the creation of a waveform data source and data block. For this example we fill an
array with a dual sine wave, ranging from - 5 to + 5.

The waveform is added to the pool and the display range and units are set.

Then the block is added to the waveform, starting at t=0 and with a delta-t of 0.001 seconds
between the samples, i.e. A sample rate of 1 kHz.

The block itself is filled with the buffer contents and an offset within the block of 0 samples.
You can add (append) more data afterwards by using a different offset.

If you run this example you can drag the newly created waveform into a display to get the
following result:
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Here you see the waveform with the user name, the corresponding X- and Y-units and values.
Note: That at this point the user data source is still a user data source and not an
IDataSrc as described earlier. E.g. the waveform is based on blocks and not on
segments.

To convert a user data source into a general purpose data source use the following code:

IDataSrc NewWaveform = MyWave as IDataSrc;
m_DataManager.PoolEntries["CSIDemo.NewWaveform"].DataSource = NewWaveform;

m_DataManager.PoolEntries["CSIDemo.NewWaveform"] .EntryType =
PoolEntryType.PoolEntryType Waveform;

The NewWaveform is an alias for the MyWave, but behaves and can be treated as a 'regular’
IDataSrc waveform pool entry.

7.4 The example

In the following example we will learn how to:
« position the measurement cursors automatically
* use the cursor positions to cut out a piece of the active trace and copy this data
+ do some operations on the copied data
* put the result back in a new trace / data source
We will use a number of techniques discussed earlier in this chapter.

7.4.1 User interface

The user interface is based on our previous examples. The following modifications will be
made:

»  The Fill Display command button will be used to as a Clear Display command button: from now
on we will use the navigators to fill the display. Hit the Clear Display button to empty the
display.

*+ Anew a area is created with a command button that will start our "analysis". A text label is
temporarily used to show the number of segments we are working on.
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Below you see the layout.

SheetControl.cs [Design] | |

Acquizsition control

Start l

Stop l Acquisition state:

Segments:

Span Channel 1

Sparn: Get

Set
Settings
Sighal coupling Input coupling
wv v
PISPLAY

Diizplay

——@ | Clear Display t[sec): ===

A. Clear display command button “FillCmd”
B. Go! analysis command button “AnalysisCmd”

C. Output label to show number of segments “SegmentsCnt”

7.4.2 The code - Getting started
We will start with some coding that needs to be done before we can actually start.

Make sure you have added the reference to the Perception.UserVariables as discussed
earlier.

Our part of the using directives region should look as follows:

using Perception.Sheets;
using Perception;

using Perception.ILO.Engine;
using DataSrcManager;

using RecordingInterface;

using Perception.UserVariables;

The region MyMembers should look like this:
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protected CtrlAcquisitionSystem m MyDemoSystem = null;
protected CtrlGroup m_GroupAll = null;

protected CtrlChannel m Channel = null;

protected DataManager m DataManager = null;

protected PoolEntry m ActiveCursor = null;

protected IDataSrc m MySource = null;

The FillCmd_Click routine is now used only to clear the display and should be stripped down
to:

private void FillCmd Click (object sender, EventArgs e)

{
// clear the display
DisplayHelper.ClearDisplay (displayl.pDisplay) ;

In this code we have used the DisplayHelper class, this class can be found in the
Perception.UserKeys reference file. It contains some useful functions related to the Perception
display.

Now we can start with the code behind the AnalysisCmd command button.

7.4.3 Manipulate measurement cursor position
In this example we will manually position a cursor on a point of interest. When the command
button is pressed a region will be created by the two measurement cursors that occupies 40%
of the horizontal display range: 20% before and 20% after the initial position of the active

cursor.

To do so create the following code:
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691
692
693
694
695
696
697
698
699
700

701
702
703

704

705
706
707
708
709
710
711
712
713
714
715

private void AnalysisCmd _Click (object sender, EventArgs e)
{

// start with defining the area of interest:

// +/- 20% of display range around active cursor

// get active cursor time position
double dActTime =
displayl.pDisplay.TimeDisplay.Cursors.ActiveItem. time;

// centre display around this time
displayl. pDisplay.TimeDisplay.CtlLayout.TimeController.CentralTime
dActTime;

// fetch start and endtime = range
double dStartTime =
displayl. pDisplay.TimeDisplay.CtlLayout.TimeController.StartTime;
double dEndTime =
displayl.pDisplay.TimeDisplay.CtlLayout.TimeController.EndTime;
double dRange = dEndTime - dStartTime;

// set interval to +/- 20% of range around active cursor time
double dStep = 0.2 * dRange;

// set cursors

dStartTime = dActTime - dStep;

dEndTime = dActTime + dStep;
displayl.pDisplay.TimeDisplay.Cursors[l].time dstartTime;

dEndTime;

displayl.pDisplay.TimeDisplay.Cursors[2].time

The code itself is very straightforward. You only need to know where to find the required
information.

* 697: get the time position of the active cursor.

» 700: centre the display around this point. Actually the time position is moved to the centre

of the display. By doing so we will not end up somewhere outside the display.
» 703 - 705: calculate the total time span of the display.
» 708: set the required measurement interval to + 20% of display range.

* 711 - 714: set the measurement cursors to the calculated position.

To verify this code you do not need any data: just grab a cursor, position it anywhere in your

display and hit the command button.

When this code runs well we can continue:
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716
717

718
719
720
721
722

723

724

// locate data source of active trace
string sActDataSource =
displayl.pDisplay.TimeDisplay.ActiveTrace.TraceProp.DataSourceName;
if (sActDataSource == null)
return;

// use only analog waveforms for the this example
m_MySource = m_DataManager.PoolEntries[sActDataSource] .DataSource;
if (m_MySource.DataType !=
DataSourceDataType.DataSourceDataType AnalogWaveform)
return;

Here we start with finding the data source of the active trace. This data source name can be
found as a trace property from the active trace. Use the returned string as pool entry.

Verify if the data source type (not the pool entry) is an analogue waveform. When all is OK
continue:

726
727
728
729
730
731
732
733
734
735
736
737
738
739

// initialize variables
object Result;
IDataSegments Segments;

// fetch data
m_MySource.Data(dStartTime, dEndTime, out Result);

// fetch segments within this data
Segments = Result as IDataSegments;
SegmentsCnt.Text = Segments.Count.ToString() ;

// no segments
if (Segments.Count == 0)

return;

727 -728: we need a Result object that is used to return the segment information from the
data source. This information is placed in Segments.

» 731: we fetch the data from the data source. Actually we fetch the segment information.
Start and end time are the values we calculated earlier.

» 734 -735: place the segment information in Segments and put the number of segments as
text in our label.

+ 738 -739: when no segments are available we quit, otherwise we continue.

Typically when we request data from a continuous recording, a single segment will be
returned. When we request data from a sweeped/transient recording, multiple segments can
be returned.

In our example we will make a copy of the active trace between the two cursor positions and
create a new waveform from this. We will also display the result.

Create the (user) waveform:
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741 // create waveform in the user data sources

742 WaveformDataBlock Block = null;

743 WaveformDataSource MyWave = null;

744 UserDataSources MySources = UserDataSources.Instance;

745 MySources .RemoveDatasource (MySources["CSIDemo.MyResult"]) ;

746 MyWave = MySources.CreateWaveForm("CSIDemo.MyResult",6 "My Waveform") ;
» 742 -743: initialize required variables.
» 744: create an instance of the user data sources collection.
»  745: for the purpose of this example: delete the waveform if it exists.
*  746: create the waveform
Once created, we need to initialize the various properties of the waveform. In this situation we
can copy various information from the original data source.

748 // set initial parameters

749 MyWave.XUnits = m MySource.XUnit;

750 MyWave.YUnits = m MySource.YUnit;

751 MyWave.DisplayRangeFrom = Segments|[l] .DisplayFrom;

752 MyWave.DisplayRangeTo = Segments[l] .DisplayTo;
We copy the X- and Y-units from the data source, the display range is copied from the first
segment. Usually the display range is the same for all segments. If you are not sure you will
have to loop through all the segments to find the maximum display range.
We can now copy the data. We loop through all segments. For each segment we will add a
block to the waveform and fill it with the relevant parameters and data.

754 // loop through all returned segments

755 for (int i = 1; i <= Segments.Count; i++)

756 {

757 int dSampleCount = Segments[i] .NumberOfSamples;

758 Segments[i] .Waveform

DataSourceResultType.DataSourceResultType Double64, 1,

759 dSampleCount, 1,

760 out Result);

761 double dXStep = Segments[i].SamplelInterval;

762

763 Block = MyWave.AddDataBlock (Segments[i] .StartTime, dXStep)

Block.WriteWaveform (0, (double[])Result);

«  755: start the loop for all segments

» 758: fetch the data: the data becomes available in Result. We request floating point data,

starting at the first sample, all samples without reduction.

*  759: get the sample interval.
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* 761: add the data block with the correct start time and sample interval.
+ 762: fill the data block with the data starting at the first position.

Note that in line 761 we use the start time of the segment. We do this because this is the exact
time of the first available sample.

Once we have added all the available information we can display the data:

765

766
767

displayl.pDisplay.TimeDisplay.CtlLayout.Pages.ActivePage.Panes.
AddPane () .Activate() ;
string[] aPoolEntry = new string[] { "CSIDemo.MyResult" };

displayl.pDisplay.AddDataSources (aPoolEntry) ;

To do so: add a pane, activate it and add our new waveform data as a trace to the active pane.

As a test: clear the display and drag waveform data into the display. Click the command
button.

A2698_05_E00_00 HBM: public 79




CSI Programming user manual HBM

7.5

Acquisition control Analysiz

Acquisition state: Gal

Segrnents: 1

Span Channel 1
Span: Get
Set

Settings

Signal coupling Input coupling

Dlizplay

Clear Display tisec)  41.157
Active Cursor Yialue

[ | Paget ]

Page 1 ‘ Bk >[E] [E][E]E] )(:415&

Clear the display and use some other data. See what happens when an event trace is the
active trace. Try to find a trace with multiple segments.

Do some basic math

At the same time we can already perform some basic manipulation on the data. As a very
straightforward example we will create an additional waveform that is a straight line. Its DC
value is the average value (mean) of the waveform interval we have just extracted.

To do so add the additional code on the appropriate places to create a second waveform:

// initialize also for calculated average value
WaveformDataBlock BlockAve = null;
WaveformDataSource MyWaveAve = null;

// create waveform also for calculated average value

MySources.RemoveDatasource (MySources["CSIDemo.MyResultAve"]) ;

MyWaveAve = MySources.CreateWaveForm('"CSIDemo.MyResultAve",
"My Average Waveform") ;

// set initial parameters also for average waveform
MyWaveAve.XUnits = m_MySource.XUnit;

MyWaveAve.YUnits = m_MySource.YUnit;
MyWaveAve.DisplayRangeFrom = Segments[l] .DisplayFrom;
MyWaveAve.DisplayRangeTo = Segments[1l] .DisplayTo;

To find the average value you must add all sample values from all segments and divide this
result by the total number of sample of all segments.

We should do this before the data is copied into our new waveform.

The following section does this calculation.
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// loop through all segments to find out the average value
double dAverage = 0;
int iTotalCnt = 0;

// for all segments
for (int j = 1; j <= Segments.Count; j++)
{
// fetch the data
int dCnt = Segments[j].NumberOfSamples;
Segments|[]j] .Waveform
DataSourceResultType.DataSourceResultType Double64,
1, dCnt, 1, out Result);
double[] Buffer = (double[])Result;

// sum all sample values
for (int m = 0; m < Buffer.Length; m++)

{
dAverage = dAverage + Buffer[m];

// sum the total number of samples
iTotalCnt = iTotalCnt + dCnt;

// calculate the average
dAverage = dAverage / iTotalCnt;

Within the loop that does the copying of the original waveform section into our new waveform
we also create the second waveform.

// create a block to waveform with average value
BlockAve = MyWaveAve.AddDataBlock (Segments[i].StartTime, dXStep)
double[] ResultAve = new double[dSampleCount] ;
for (int k = 1; k <= dSampleCount; k++)
{
ResultAvel[k - 1] = Convert.ToSingle (dAverage) ;

}
BlockAve.WriteWaveform (0, ResultAve) ;

And after we have added the trace to the display we will also add the second trace to the
display, overlaid on the first trace with a different color.

// add also - overlaid - the average value

aPoolEntry = new string[] { "CSIDemo.MyResultAve" };
displayl.pDisplay.AddDataSources (aPoolEntry) ;
displayl.pDisplay.TimeDisplay.CtlLayout.ActiveTrace.TraceProp.PrimaryColor
= OxO00FFFF; // yellow
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When you run the code the result could look like this:

Acquisition contral Analysiz

Acquigition state:  Idle Gal Segments:

Span Channel 1

Span: |20 Get
Set SR P T
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§ |" 1| f '| 1A
i I I
Settings : | | || | 'l | || I|
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||| Jl | || I| f
b
DC v SE Positive  w '
Diizplay

Clear Display el B2.713

50,00 mes/div
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Here you see a situation in which there are two segments, the left-most with a lower sample

rate.

For verification a formula in the formula database was created with the same calculation:

CalcAvg = @Mean(CSIDemo.MyResultAve)

This result is shown in a second meter that was dragged into the meter area we already had.

7.6 Using Perception waveform calculators

Perception has some built in calculators which are accessible via CSI. The calculators work on
a single waveform, they can work on the complete waveform from beginning to end or you can

define the interval for calculation.

The following calculators are available:
e WavMinMax - Finds Min, Max, MinPos and MaxPos
e WavFastMinMax - Finds only Min and Max

e WavAreaEnergy - Finds Area and Energy under curve

e WavPeriodandCounter - Finds Period, Frequency and number of Cycles

e WavPulse - Finds pulse characteristics like Rise Time, Fall Time and Pulse Width

e WavsStatistics - Finds Mean, RMS and Sigma
e WavHistogram — Returns histogram array
e WavFindLevelCrossing - Finds the position of a level crossing

e WavFindLocalExtreme - Finds the local extremes
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For our example we will calculate the maximum and minimum values and their positions. You

can have a look in the HBM — Perception Interfaces help file to get detailed information on the
WavMinMax class.

erception Interfaces EEX

o z =
Hide Locale  Back Stop  Refresh Home  Print  Oplions

HEBM - Perception Interfaces

WavMinMax Class

+ @ Perception NavigatorTrees NodeSorters Namesp & > R i c# -
= @ Perception NavigatorTrees RecordingExplorero
= @ Perception Processing Namespace

= @ Perception Processing Adtions Namespace

= @ Perception Processing Dialogs Namespacs =l Declaration Syntax

= @ Perception Processing.Ul Namespace c# Visual Basic visual C++
= @ Perception SequencerEngine Namespace

= @ Perception SequencetEngine Sequence Settings I
= @ Perception SetingsControls Namespace

Contents |ipdex | Search | Favorjes |

This calculator caleulates the minimum and maximum value and their positions of a waveform (between StartTime and EndTime).

public class WaviinMax : WavBase

=l Members
+ @ Percspiion Shesls Namespacs All Members Constructors Methods Properties
= @ Perception Sheets Formula Namespace = = =
= @ Percaption Sheets Formula.Contrals Namespace St Bz Iz =z
+ @ Perception Sheets.Formula.Sheetinformation Nam W Protected ¥ static W Inherited
= @ Perception Sheets HPHY_AutomatedAnalysis Nai Icon Member Description
# @ Perception Sheets InfaSheet Namespace @  wavMinMax(IDatasre, Double, Double) Constructor of the min/max calculator.
= @ Perception.Sheets InfoSheet Enumerations Names
+ @ Perception Sheets InfoSheet Interfaces Mamespac
« @ Perception Sheets InfaShest Variables Nemespar & End End positien of time interval used for the calculations.
= @ Perception Shests InfaSheet Variahles Delegates
+ @ Perception.Sheets LogSheet Namespace Max Maximum value of the waveform between start and end time.
P g P
= @ Perception Sheets LogSheet Controls Namespace
- : EEFEEF:‘N\ 2:52:5 tﬂqz:ee:?a‘nqs T\‘Jame’ipacs f MaxPos Pesition of the maximum value of the waveform between start and end time.
# erception. Sheets.LogSheet Enumerations Name
= @ Perception Sheets LogSheet Settings Controls Nau
= @ Perception Sheets Reporting Namespace & Min Minimum value of the waveform between start and end time.
= @ Perception.Sheets Reporting.Sheetirfarmation Na.
% @ Perception Sheets SequencerSheet Namespace 5 MinPos Position of the minimurm value of the waveform between start and end time.
= @ Perception Sheets SequencerSheet Cortrols Narn
+ @ Perception Sheets. SecuencarSheet Dialags Nam
= @ Perception.Sheets.SequencerShests.Controls Nar @ Result(Double, Couble, Double, Double) Returns the result of the min/max calculator.
= @ Perception Sheets Settings Namespacs
= @ Perception Sheets Settings Configuration Mamesp o Start Start position of time interval used for the calculations.
= @ Perception.Sheets. Settings. Sheetinfarmation Nam
= @ Perception Sheets Settings Wizard Namespace
= @ Perception Sheets Standard Namespace = Remarks

= @ Perception Shests Standard Sheetintormation Har This calculstor returns the maximum and minimum value and their positions between 'Start’ and 'End’ time. When only the maximum eor minimum valuz
+ @ Perception.Sheets Status Namespace is wanted then use the WavFastMinMax calculator.

= @ Perception Uservariables Namespace
= ({3 Perception WavCalc Namespace

[ CrossingType Enumeration c#

= @ DataSourceProcessor Class

=l Examples

53 copy

WavMinMax Calculator - new WavMinMax (iActiveTrace, double.MinValue, double.Maxvalue):

[E] ExtremeType Enumeration WavCalcResult CalcResult = Calculator.Exec();

[£] ScanMoceType Enumeration
& @ SegmentProcessar Class if (CalcResult !'= WavCalcResult.OK)

{

+ @ STL_TDG_Reader Class MessageBox.Show (this, "Can mot caleulate Max/Min\rim\r\n® + Calculator.ErrorCode, "CSI Displa:
= @ WavAreaEnergy Class [
= @ ‘WavBase Class ]

[£] WavCalcResult Enumeration
& @ WenFasiMinax Class double dMin: double dMax; double dMinPos; double dMexPos:

Calculator.Result (out dMin, out dMax, out dMinPos, out dMaxPos):
[£1 WavFindDirection Enumeration g ‘ B " J

= @ ‘WavFindLevelCrossing Class
= @ wWayFindLocalExtreme Class
= @ WavHistogram Class

= @ Wavhinhax Class

= @ WavMinMaxCalculations Class

=l Inheritance Hierarchy

= @ WavPeriodAndCounter Class - see Also

= @ WavPulse Class WavFastHinMax

= @ WavStatistics Class
= @ Perception Win32 Namespace Send comments on this topic to HBM - CSI Support
= @ Percaption Win32.DxShow Namespace ) Copyright @ 2008, HEM

= Assembly: Pert Calc (Module: Per Calc) Version: 6.0.9064.1215
< >

After the maximum, minimum, maximum position and minimum position are found the vertical
and horizontal cursors will be set. We also label the two points with two Perception trace
markers.

Extend the last example with a groupbox called Calculations see picture below.
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In order to create a calculator you will need to add a reference to the Perception.WavCalc dll

Also add a reference to the Perception.Common dll because this dll contains the conversion
routines.

Add the following code behind the button Calculate event click:

84
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private void btnCalc_Click(object sender, EventArgs e)
{
// Get Active Trace
DTrace myTrace = displayl.pDisplay.TimeDisplay.ActiveTrace;
if (myTrace == null)
{
PerceptionMessageBox.Show(this, "No active trace found",
"CSI Display Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

// Get datasource from active trace
IDataSrc iActiveTrace = myTrace.TraceProp.DataSrc;
if (iActiveTrace == null)
{
PerceptionMessageBox.Show(this, "Active trace has no datasource",
"CSI Display Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

// Create a new Min Max calculator

WavMinMax Calculator = new WavMinMax (iActiveTrace,
double.MinValue, double.MaxValue) ;

// Execute the calculator

WavCalcResult CalcResult = Calculator.Exec() ;

// Check if result is OK

if (CalcResult !'= WavCalcResult.OK)

{

PerceptionMessageBox.Show(this, "Can not calculate Max/Min\r\n\r\n" +
Calculator.ErrorCode, "CSI Display Demo", MessageBoxButtons.OK,
MessageBoxIcon.Error) ;

return;

}

// Get the results from the calculator
double dMin; double dMax; double dMinPos; double dMaxPos;
Calculator.Result(out dMin, out dMax, out dMinPos, out dMaxPos) ;

// Show the results using Perception conversion functions

lblMax.Text = Conversion.ConvertDoubleToString(dMax, 4,
iActiveTrace.YUnit) + iActiveTrace.YUnit;

1blMin.Text = Conversion.ConvertDoubleToString(dMin, 4,
iActiveTrace.YUnit) + iActiveTrace.YUnit;

lblMaxPos.Text = Conversion.ConvertDoubleToString(dMaxPos, 4,
iActiveTrace.YUnit) + iActiveTrace.XUnit;

1blMinPos.Text = Conversion.ConvertDoubleToString(dMinPos, 4,
iActiveTrace.YUnit) + iActiveTrace.XUnit;

// Position the vertical cursors at the maximum and minimum position
displayl.pDisplay.TimeDisplay.Cursors[1l].time = dMaxPos;
displayl.pDisplay.TimeDisplay.Cursors[2].time = dMinPos;

// Set the Horizontal cursors to the maximim and minimum levels.
displayl.pDisplay.TimeDisplay.CtlLayout.HorizontalCursors.Visible = true;

// Get the high and low display range values from the active trace
double dHigh, dLow;

myTrace.TraceProp.GetRange (out dHigh, out dLow) ;

// Use these values to get the relative levels via a lineair
//conversion

double dLevell (dMax - dLow) / (dHigh - dLow) ;

double dLevel2 = (dMin - dLow) / (dHigh - dLow) ;

// We also need to know the position of the active pane.
double dTop = 1;

double dBottom = 0;

myTrace.Pane.GetPositions (ref dTop, ref dBottom) ;
dLevell = (dTop - dBottom) * dLevell + dBottom;

dLevel2 = (dTop - dBottom) * dLevel2 + dBottom;
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// Now we can set the relative level values

displayl.pDisplay.TimeDisplay.CtlLayout.HorizontalCursors[l].Location
dLevell;

displayl.pDisplay.TimeDisplay.CtlLayout.HorizontalCursors[2] .Location
dLevel2;

// Set a display marker for the maximum value.

// First clear all existing markers
ClearAllMarkers() ;

// Create a new display marker to indicate the maximum position
DisplayMarker myTraceMarkerMax = myTrace.DisplayMarkers.AddMarker (
DisplayModeType.DisplayModeType Review) ;
myTraceMarkerMax.DrawingType =
MarkerDrawingType.MarkerDrawingType TraceMarker;
myTraceMarkerMax.MarkerStartSourceX = dMaxPos;
myTraceMarkerMax.MarkerStartSourceY = dMax;
myTraceMarkerMax.UnformattedText = "Max";
myTraceMarkerMax.SetLabelPosition (DisplayModeType.DisplayModeType Review,
LabelAlignment.LabelAlignment Left, -0.1, -0.1);

// Create a new display marker to indicate the minimum position
DisplayMarker myTraceMarkerMin = myTrace.DisplayMarkers.AddMarker (

DisplayModeType.DisplayModeType_Review) ;
myTraceMarkerMin.DrawingType =

MarkerDrawingType .MarkerDrawingType TraceMarker;
myTraceMarkerMin.MarkerStartSourceX = dMinPos;
myTraceMarkerMin.MarkerStartSourceY = dMin;
myTraceMarkerMin.UnformattedText = "Min";

myTraceMarkerMin.SetLabelPosition (DisplayModeType.DisplayModeType Review,
LabelAlignment.LabelAlignment Left, 0.1, 0.1);

86
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The following code is used to clear all display markers.

// Clears all existing markers
private void ClearAllMarkers ()
{
// get the number of display pages
int NumberOfPages = displayl.pDisplay.TimeDisplay.CtlLayout.Pages.Count;
// Remove the markers per page
for (int i = 1; i <= NumberOfPages; i++)
{
DPage myPage = displayl.pDisplay.TimeDisplay.CtlLayout.Pages[i];
// Get the display markers collection from the page
DisplayMarkers myDisplayMarkers = myPage.DisplayMarkers;

// Keep on deleting the markers until the collection is empty
while (myDisplayMarkers.Count > 0)
{
DisplayMarker myPageDisplayMarker = myDisplayMarkers[1l];
myPageDisplayMarker.Delete() ;
}

// Now we will delete the display markers connected to the individual
// traces. Therefore we have to loop through the panes

for (int n = 1; n <= myPage.Panes.Count; n++)

{

DPane myPane = myPage.Panes[n];

// Go through all the traces from this pane

for (int m = 1; m <= myPane.Traces.Count; m++)

{
DTrace myTrace = myPane.Traces|[m];
// Get the display markers collection from this trace
DisplayMarkers myTraceDisplayMarkers = myTrace.DisplayMarkers;

// Keep on deleting the markers until the collection is empty
while (myTraceDisplayMarkers.Count > 0)
{
DisplayMarker myTraceDisplayMarker =
myTraceDisplayMarkers[1];
myTraceDisplayMarker.Delete() ;

If you compile and run the code then drag and drop a trace into the display you can click the
Calculate button. The vertical and horizontal cursors will be set, two trace markers will be
added and the numerical data is displayed into the calculation groupbox.
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The two display markers are also added automatically to the pool of Data Sources, you can
find them with the Data Sources navigator as show in the picture below.
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8.1

8.1.1

Data Analysis - Part Two

Within Perception the advanced analysis option allows you to define your own formulas so as
to compute results in seconds rather than hours.

A "formula database" is used to enter math expressions like CH1*CH2 or MAX@CHL1 to
compute results immediately when new data arrives. The formula results can be re-used in
other formulas to get even more advanced answers.

With Perception CSI you have access to the formula database. The formula database is a
powerful tool to quickly evaluate complex expressions in your application, simply by inserting a
formula into the database, and evaluating the function.

In addition you can also create your own functions, functions that are not already part of the
formula database.

In this chapter we will discuss both implementations.

Formula database as calculator

It is not difficult to use the formula database in your code to perform calculations. Simply add a
reference to the formula database functions in your project and add the required formula "as
text" to the database. Perception will do the math and update for you.

We will continue with our example from the previous chapter and do the following:

+ add the formula database reference to our project

* add aformula to calculate the minimum of the waveform segment we created

* add a formula that returns the time position of this minimum

*  position the cursor on this point

Please note that when the Advanced Analysis option is not installed in Perception, the code
will 'install' correctly, but no results will become available from the formula database.

User interface

The only thing we want to do is to display the minimum value. You can do this either by
dragging the result into the meter area (or create an additional meter in the user interface) or
use new text labels. In this example we will go with this last option. We will add a new group
box called “Using Formula Database” see next picture.
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8.1.2 The code
Start with adding the correct reference to the project.
To add the Perception Formula Database reference
1 Goto Project > Add Reference...
2 Inthe dialog that comes up select Browse...
3 Navigate to the Perception folder. Typically C:\Program Files\HBM\Perception.
4  Select the file Perception.FormulaDatabase.dll and click OK.
Now the reference is added.
Add a using statement as follows:
"using Perception.FormulaDatabase;

The following code has to be added in the new button event click

1082 | private void btnCalcUsingForDB Click (object sender, EventArgs e)

1083 {

1084 // Get Active Trace

1085 DTrace myTrace = displayl.pDisplay.TimeDisplay.ActiveTrace;

1086 if (myTrace == null)

1087 {

1088 PerceptionMessageBox.Show(this, "No active trace found",

1089 "CSI Display Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
1090 return;

1091 }

1092 // Get datasource from active trace

1093 IDataSrc iActiveTrace = myTrace.TraceProp.DataSrc;

1094 if (iActiveTrace == null)

1095 {

1096 PerceptionMessageBox.Show(this, "Active trace has no datasource",
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1097
1098
1099
1100
1101
1102
1103
1104
1105
1106
1107
1108
1109
1110
1111
1112
1113
1114
1115
1116
1117
1118
1119
1120
1121
1122
1123
1124
1125
1126
1127
1128
1129
1130
1131
1132
1133
1134
1135
1136

"CSI Display Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

}

// Get Data source name from trace
// e.g.: "Active.Groupl.Recorder B.Burst"
string cDSName = myTrace.TraceProp.DataSourceName;

// create required formulas in formula database

// create instance of formula database
FormulaDB ForDB = FormulaDB.Instance;

// check if formula already exist
if (ForDB.Formulas["CSI:MinVal"] == null)
{
// search for an empty line
foreach (Formula frml in ForDB.Formulas)
{
if (frml.IsEmpty())
{
// Define Name, Formula and Units
// (See columns formula database sheet)

frml .Name = "CSI:MinVal";

// Expression can be: "@Min (Active.Groupl.Recorder B.Burst)"
frml .Expression = string.Format("@Min({0})", cDSName) ;
ForDB.Formulas[frml.LineNumber + 1] .Name = "CSI:MinPos";

// Expression can be: "@MinPos (Active.Groupl.Recorder B.Burst)"
ForDB.Formulas[frml.LineNumber + 1] .Expression =
string.Format ("@MinPos ({0})", cDSName) ;

// fetch units from source

m_MySource = m_DataManager.PoolEntries[cDSName] .DataSource;
frml.Units = jActiveTrace.YUnit;
ForDB.Formulas[frml.LineNumber + 1].Units = iActiveTrace.XUnit;
break;

1108: Create the single instance of the formula database.

1111: check if formula with that name already exists. Here we perform a very simple test.
In reality this should be better.

1114 - 1116: we scan through the complete formula database in search of the first empty
line.

1118 - 1122: enter the formula name and the formula itself. Here we use the loop variable.

1123 - 1123: next formula. Here we use the exact line number, which is the variable's line
number + 1

1139 - 1131: enter the units. These are the same units as from the original data source.

At this point the correct formulas are created. We now use these calculated values that are in
the data pool. After use we clean it up. When you do not remove them, they will show up in the
Data Sources Navigator and the formulas sheet.
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1137
1138

1139
1140
1141
1142
1143
1144

1145
1146
1147
1148
1149
1150
1151
1152
1153
1154

// display formatted value

m_MySource =
m_DataManager.PoolEntries["Formula.CSI:MinVal"] .DataSource;

double dMinVal = (double)m MySource.Value;

1blMinForDB.Text = Conversion.ConvertDoubleToString(dMinval, 4,
iActiveTrace.YUnit) + iActiveTrace.YUnit;

// place cursor

m_MySource =
m_DataManager.PoolEntries["Formula.CSI:MinPos"] .DataSource;

if (m_MySource == null) return;

double dMinPos = (double)m MySource.Value;

displayl.pDisplay.TimeDisplay.Cursors[l].time = dMinPos;

1blMinPosForDB.Text = Conversion.ConvertDoubleToString(dMinPos, 4,

iActiveTrace.XUnit) + iActiveTrace.XUnit;

// once done: clean up the mess
ForDB.Formulas["CSI:MinVal"].Clear()
ForDB.Formulas["CSI:MinPos"] .Clear() ;

Of course the formulas can be as extensive as required. Also you may leave them in the

1137 - 1139: fetch value and cast it to a double.
1140: use the ConvertDoubleToString() function to display the minimum value.
1144 - 1149: fetch position of value and place cursor on it.

1152 - 1153: remove the formulas.

formula database when required.
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If you have compiled and run your code the following information can be shown after a
calculate button click:
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8.2 Make your own functions

In the previous section we have seen how you can use the formula database to create 'volatile
calculations. In this section we will discuss how you can create 'non-volatile' functions that
become an integral part of the formula database.

You can create such a function in your CSI sheet. It then becomes part of the Perception
software when this sheet is loaded.

There is also a second - more general - option. You can build your function in a Windows
Class Library, this dll has to be saved into the Perception subfolder Functions. When
Perception starts and it finds such a "dII" it will load this code and - assuming the advanced
analysis option as well as the CSI option are installed - add the function to the formula
database. |.e. you will have access to your very own built function any time you start
Perception.

In this section we will explain the second option: create an external file that comprises your
own functions that are always available whenever you run Perception.

As an example we will create a function that we have done already once: create a waveform
that is a straight line. Its DC value is the average value (mean) of a selected waveform or part
of the waveform.

Fage 1 @) HEE -.[E]E][E] X=5.41B817905 | AX=5418179
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8.2.1

8.3

Create and initialize the external class library

To create the class library in Visual Studio: select File > New > Project....

l INEWI 0BT Ja
Project types: Templates: BE
= Visual Basic ZJ|  visual Studio installed templates
Windows |
OFffice _EWindows Application llEclass Library
+- Smart Device ,@Winduws Control Library v@Web Control Library
Database (2% Console Application [5Awindows Service
Starter Kits [c¥] Empty Project
Test
(=) Wisual C# My Templates
Windows
Office aJPerception CSI Sheet 3 visionConnection
+- Smart Device __'i]Search Online Templates...
Database
Starter Kits
Test
- Visual C++
41 Nther Praiect Tunec -
A project for creating a C# class library (.dll)
Mame: FormuIaDBFunctionsl
Location: D:\CSharpExamples v
Solution Name: FormulaDBFunctions Create directory for solution
[ OK ] [ Cancel ]

In the dialog that comes up select a Visual C# Windows project. Select as template the Class
Library. Give the project a name and click OK.

Add the required references:
1 Goto Project > Add Reference...
2 Inthe dialog that comes up select Browse...
3 Navigate to the Perception folder. Typically: C:\Program Files\HBM\Perception.
4 Multi-select the files Perception.FormulaDatabase.dll,
Perception FormulaDatabase.FunctionSupport.dll, Perception.Interops.dll and click
OK.
Now the references are added.
Add the following using clauses:
using Perception.FormulaDatabase.Functions;
using Perception.FormulaDatabase.FunctionSupport;

using RecordingInterface;

Now we can start with the initial code.

The function information

When you want to create your own functions to be used in Perception, you first need to create
a "function information" module for that function. This module is implemented as a class which
implements the IFunctioninfo interface.

The formula database engine searches for classes implementing the IFunctioninfo and creates
instances of these classes to get the relevant information.

94
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When a function is used in a formula, the IFunctioninfo interface is used to create an instance

of that function.

To create the IFunctioninfo interface proceed as follows:

Type the line of code:

||pub1ic class CSIFunctionInfo : IFunctionInfo

Now you should see below the "I" from IFunctioninfo a small rectangle. Click on the rectangle:

1E using Systen:
Z:| using System.Collections.Generic;
3| using System.Text;

using NicoletRecordingInterface;

9¢ namespace FormulaDBFunctions

12 E}W
13

4
5| using LD3.FormulaDatabase.Functions;
6| using LDS.FormulaDatabase.FunctionSupport;

interface LDS,FormulaDatabase. Functions. IFunctionInfo
The IFunctionInfo interface is used by the Formula engine to get information about the function and to create a function object

10:] ¢
11[L public class C3IFunctionInfo :

IFunctionInfo
ER

lmblement interface ‘TFunctionInfa’ |

Explicitly implement interface TFunctionInfo’

and select Implement Interface 'IFunctioninfo’.

A complete code block will be implemented:

{

{

{

#endregion

public class CSIFunctionInfo : IFunctionInfo
#region IFunctionInfo Members
public string Category

get { throw new Exception/(
"The method or operation is not implemented."); }

public nicDataManager.PoolEntryType[] ParameterTypes

get { throw new Exception/(
"The method or operation is not implemented."); }

We must now fill all these 'entries’ with the correct information.
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8.3.1 Category

This entry is used by the function wizard (when implemented in your version of the software) to
place the function within a specific category.

public string Category

{
get
{

return "CSI Functions";

8.3.2 CreateFunction

This entry creates the new function. For this example we use the internal name
"CreateWaveformFromAverage".

public IFunction CreateFunction()

{
// for testing purposes as long as the function
// is not implemented: return null;
return new CreateWaveformFromAverage () ;

As long as the actual function is not yet implemented we return "null".

8.3.3 Description
A literal description of the function.

public string Description
{
get
{
return "Creates a DC waveform with value of average of the
waveform to process (InWave).";

8.3.4 Example
Provides an example on how to use the function.

public string Example

{
get

{
return "QCSI_MeanWave (Active.Groupl.Recorderl.Ch_A2)";
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8.3.5 MinimumParameterCount

This value indicates the minimum number of parameters required by the function. Must be at
least one (1).

public int MinimumParameterCount

{
get

{

return 1;

}

8.3.6 Name

The name of the function exactly as it will appear in the function list without the "@" character
in front.

public string Name

{
get

{

return "CSI_MeanWave";

8.3.7 Parameters

Each parameter has a name, type and description. The name and description are strings, the
type is a PoolEntryType. Multiple parameters can be required. Therefore these values are all
returned as arrays.

8.3.8 ParameterDescriptions

These are literal descriptions of each parameter. For the purpose of our example only one
parameter, and therefore one description, is required.

public string[] ParameterDescriptions
{
get
{
string[] ParamDescriptions = {"The waveform to process"};
return ParamDescriptions;

8.3.9 ParameterNames

These are the names of each parameter. For the purpose of our example only one parameter,
and therefore one name, is required.

public string[] ParameterNames

{
get

{
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string[] ParamNames = {'"InWave"};
return ParamNames;

8.3.10 ParameterTypes
These are the parameter types as they are known in the data pool: the data pool entries.

public nicDataManager.PoolEntryType[] ParameterTypes
{
get
{
nicDataManager.PoolEntryType[] PETypes =
{nicDataManager.PoolEntryType.PoolEntryType Waveform};
return PETypes;
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8.4 Getting it all to work
At this point we should be able to test the IFunctioninfo interface.
The most important part is to create this dll and put it in the correct folder.

The file must be placed in the Perception program folder, typically C:\Program
Files\HBM\Perception\Functions.

To get this done we need to modify the properties of the project.
1 Goto Project > <projectname> Properties...

2 Inthe Build tab locate the Output section and set the Output path to the Perception
program path, typically C:\Program Files\HBM\Perception\Functions.

Run the code and when Perception starts go to the Formula sheet.

When you type an "@" on a formula command line, the drop-down list should list the new
function and when you select that function the provided information must be available.

E Formula |

A CSI_MeanWave( Wavefom InWave )
Tools S =

Input Type Description
+ + - = InWave: Waveform The waveform to process
Operators S

[E]E] Example: @CS|_Meanwave[active.Group1.Recorder!.Ch_a2)
Category: (Sl Functions

Creates a DC waveform with value of average of the waveform to process (InWave).

Help S ——
CSI_Meanw ave( Num Name Formula ‘
...... e Wavo G : |
Creates a DC waveform with 2 CSI_MeanwWave A~
value of average of the Cut
waveform to process (Inwave). 3 Cycles
Diff
4 Energy
5 Exp
Exp\wWave
6 FallTime
7 Frequency
Histogram
8 Integrate
g IntLookUp
Join
10 Length 7|
11

Have a close look to the output and modify some parameters in your code to see the various
results.
8.5 Implement the function
To actually implement the function there are two options:
* The comprehensive method
* The intelligent method

Both methods have their advantages. The intelligent method uses code that has already been
defined and tested in Perception. This will cover 90% of the applications. For very specific

A2698_05_E00_00 HBM: public 99



CSI Programming user manual HBM

requirements you might need to use the comprehensive method. We will explore the intelligent
method, but before we start give an idea of the comprehensive method.

8.5.1 Using the comprehensive method

Once we have defined the IFunctioninfo we need to implement the IFunction function that is
returned by the CreateFunction entry of the IFunctioninfo.

The IFunction requires three methods:

* Init Initialize: an array of datasource interfaces is passed in and a resulting datasource
should be returned.

* Reset The method that is called by the calculation engine to reset the function when a
DataChanged or DataSourceChanged event is processed.

* OnDataAdded Tells the calculation engine which type of event should be fired when a
DataAdded event is being processed.

As a general example have a look at the following code:

class ExampleFunction : IFunction, IDataSrc

{
protected IDataSrc[] m_Arguments;

public void Init(IDataSrc[] Parameters, out IDataSrc Result)
{

m_Arguments = Parameters;
Result = this;

public PoolEventType OnDataAdded (double StartTime,
double EndTime)

{
return PoolEventType.DataChanged;

public void Reset()
{
}

// IDataSrc implementation

}

The difficult part starts at the last line: IDataSrc implementation. Here you will need to
implement the complete IDataSource interface for your routine. This includes Data, DataType,
GetUTCTime, GetValueAtTime, Name, Properties, Status, etc. To see a complete list follow
the procedure described to quickly implement the IFunctioninfo.

As mentioned earlier this method may be useful for very special situations where the intelligent
method fails, or when you only need to perform a very basic calculation that returns a single
value.
For the purpose of this manual we will continue with the intelligent method.

8.5.2 Using the intelligent method
The intelligent method is based on inheritance and the override method that provides a new

implementation of a member inherited from a base class. We will build the function code based
on well-tested, existing classes from Perception.
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Without going into details we start by using the SampleBySampleOrNumericalFunction
class. When you start typing your entry for the class, Visual Studio will assist you in a correct
inheritance of the base class. Your first result should look like this:

public class MyExample : SampleBySampleOrNumericalFunction
{
protected override SampleBySampleDataSegment CreateWrapperSegment
IDataSegment OriginalSegment)
{
throw new Exception(
"The method or operation is not implemented.");

protected override object ProcessValue (object Value)

{

throw new Exception(
"The method or operation is not implemented.");

}

As you can see this inheritance requires two method overrides:
+ CreateWrapperSegment

* ProcessValue

The last one is the easiest one for us. ProcessValue is a method that is called when
‘'somebody’ needs to have a single value processed using our function. E.g. when the result of
our function is displayed, a cursor movement would request a single value at the cursor
position. It therefore passes the value of the original data to this method and expects a result
back. This is true since we perform a ‘'sample-by-sample' function.

A more detailed example: assume our function divides a waveform by 10 and puts the result
back in a result: result waveform = (original waveform) / 10. Each sample of the result is one-
tenth of the value of the original value.

What happens when a measurement cursor is between two samples? It (the cursor engine)
will do a calculation of the Y-value based on linear interpolation between the two samples and
pass that value to our function. Our function does its trick (divides the value by 10) and returns
the result. E.g. a sample with value 10 and a sample with value 12. The cursor is exactly in the
middle: it passes 11 to our function and the return value should be 1.1, which is exactly
between 1.0 and 1.2.

In our programming example it is even simpler: we always return the calculated average.

The CreateWrapperSegment is a little bit more complicated to understand. Basically what
happens is the following: the SampleBySampleOrNumerical class takes care of the complete
handling of a waveform and therefore also supports the segments as we know them from the
IDataSrc interface. Since we are performing analysis on a waveform on a sample by sample
basis we need to process each original segment individually and return a processed segment.
That is where the CreateWrapperSegment comes in.

The CreateWrapperSegment provides an original segment and should return a processed
segment. These segments are of type SampleBySampleDatasegment. Therefore the
override must:

* Get the average value of the complete waveform

+ Create a new segment based on the calculation
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To calculate the average value of the complete waveform is not difficult as we will demonstrate
later in this section.

Processing the segment will be done in a separate class based on the
SampleBySampleDataSegment. When we start defining this class the initial result will look like
this:

public class MyWrapper : SampleBySampleDataSegment
{
public override void ProcessSamples (double[] fSamples)

{

throw new Exception(
"The method or operation is not implemented.");

The only required override is the ProcessSamples, i.e. we must process all samples which is a
valid requirement.

Summarized we need to perform the following main actions:

+ create a class based on the SampleBySampleOr Numerical class

+ create a class based on the SampleBySampleDataSegment

+ find a way to calculate the average value of the original data source

If we assume that we have our average value we can start with coding the SegmentWrapper
class for our purpose.

92
93
94
95
96
97
98
929
100
101
102
103

104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119

class AverageWrapperSegment : SampleBySampleDataSegment

{
// this class uses the "SampleBySampleDataSegment"
// as base class. Creates a waveform segment that is a DC value
// DC = a calculated average value

// internal member
double m DeAverageValue;

// constructor, requires a data segment, the average value
// and uses base class for "difficult" stuff
public AverageWrapperSegment (IDataSegment OriginalSegment,
double DeAverageValue) : base(OriginalSegment)
{

// copy average value to internal

m_DeAverageValue = DeAverageValue;

public override void ProcessSamples (double[] fSamples)
{
// override the process samples method.
// This one gets a segment of samples in a double array
for (int nSample = 0; nSample < fSamples.Length; nSample++)
{
// replace each sample with the average value
fSamples[nSample] = m_DeAverageValue;

102
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* 98-99: create a local variable for storage of the average value

+ 101 - 103: the class expects as input the original data segment and the calculated average
value. Uses the OriginalSegment class as base.

+ 104 -107: in the constructor we copy the average value to our internal variable
+ 109 - 118: the ProcessSamples gives us an array of flaoting point samples that we may
use to create our own data. We do this by simply replacing each sample by the average

value.

At this point we can start implementing our formula database function "CSI_MeanWave". The
function internally is CreateWaveformFromAverage.

131

132
133
134
135
136
137
138
139
140
141
142

143
144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159
160
161
162
163

public class CreateWaveformFromAverage
SampleBySampleOrNumericalFunction

// this class uses the "SampleBySampleOrNumericalFunction"
// it creates a complete waveform that is a DC value
// The DC value = a calculated average value

double m _Average = double.NaN;

// override the CreateWrapperSegment

// it creates an interim data segment, calculates the average

// and passes it to the interim data segment

protected override SampleBySampleDataSegment CreateWrapperSegment
IDataSegment OriginalSegment)

CalculateAverageOfSource() ;
return new AverageWrapperSegment (OriginalSegment, m Average) ;

private void CalculateAverageOfSource ()
{
if (!double.IsNaN(m_Average))
return;
IDataSrc myDS = m Parameters[0];
// calculate average here, for testing now =1
m_Average = 1;

protected override object ProcessValue (object Value)

{
// override the ProcessValue method and perform calculation
CalculateAverageOfSource() ;
return m_Average;

« 137: define the internal variable for the average value and initialize as Not a Number (NaN)
* 142 - 146: here is the override of the CreateWrapperSegment method
* 144: a call to calculate the average value

« 145: return the result of the segment calculation. This is a SampleBySampleDataSegment
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created by a new AverageWrapperSegment object. Our AverageWrapperSegment uses
the OriginalSegment and the average value as input.

* 148 - 155: calculate the average value
» 150 - 151: if our average value is a number, then we're done

+ 152 - 154 for testing purposes so far: fetch the original data source, do nothing and give
the average value a temporary value, e.g. 1

+ 157 - 162: implement the ProcessValue override as discussed earlier.

We are now ready for another test. We can start using the function. The result is again a
straight line, now with a value of "1" and the length is equal to the length of the waveform we
use as input.

When you move a cursor, the reading should also be available through the ProcessValue
implementation (try another value as proof of concept!).

Depending on your data source you might run into trouble with this particular example: when
you have a data source that has all values below "1" you will not see the straight line on your
display. Therefore you must 'set' the correct display range. This is also true for other
calculations. E.g. when you multiply a source with 10, the scaling must also be set to 10 times
higher.

As we have seen already in a previous chapter segments provide display range information.
When we go to the definition of SampleBySampleDataSegment we will find nothing that relates
to a display range. However, we see that it is based on DataSegmentWrapper. Go to that
definition and you will see an override possibility for the display range. (use the Go To
Definition function of Visual Studio to see the definition or meta data).

A basic implementation could now be - in the AverageWrapperSegment class:

public override void DisplayRange( out double DisplayFrom,
out double DisplayTo )

base.DisplayRange (out DisplayFrom, out DisplayTo) ;
DisplayFrom = base.DisplayFrom;
DisplayTo = base.DisplayTo;

}

First we fetch the DisplayFrom and DisplayTo values from our base segment (the original
segment). After this we copy these values onto our own DisplayFrom and DisplayTo properties
of the newly created segment.

For the purpose of our example we could implement the following code:

public override void DisplayRange( out double DisplayFrom,
out double DisplayTo)
{
base.DisplayRange (out DisplayFrom, out DisplayTo) ;
if (DisplayFrom < m _DeAverageValue)
DisplayFrom = 2 * m DeAverageValue;
if (DisplayTo > m_DeAverageValue)
DisplayTo = -2 * m DeAverageValue;

}

For the calculation of the average value we can use (part of) the code we already have
implemented.

104 A2698_05_E00_00 HBM: public



I
o
<4

CSI Programming and user manual

188
189
190
191
192
193
194
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156
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158
159
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16l
162
163
l64
165
166
167
168
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171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187
188
189

private void CalculateAverageOfSource ()

{

if (!double.IsNaN(m_Average))
return;

// m_Parameters array is part of the inherited Functionbase
// m_Parameters[0] is the data source
IDataSrc myDS = m Parameters[0];

// calculate average

// use only analog waveforms for the this example

if (myDS.DataType != DataSourceDataType.DataSourceDataType
AnalogWaveform)
return;

// initialize variables
object Result;
IDataSegments Segments;

// fetch data
myDS.Data (myDS.Sweeps.StartTime, myDS.Sweeps.EndTime,
out Result);

// fetch segments within this data
Segments = Result as IDataSegments;

// no segments
if (Segments.Count == 0)
return;

// loop through all segments to find out the average value
m_Average = 0;
int iTotalCnt = 0;

// for all segments

for (int j = 1; j <= Segments.Count; j++)

{
// fetch the data
int dCnt = Segments[]j] .NumberOfSamples;
Segments[j] .Waveform(DataSourceResultType.
DataSourceResultType Double64, 1, dCnt, 1, out Result);
double[] Buffer = (double[])Result;

// sum all sample values
for (int m = 0; m < Buffer.Length; m++)
{

m_Average = m_Average + Buffer[m];

// sum the total number of samples
iTotalCnt = iTotalCnt + dCnt;

// calculate the average
m_Average = m_Average / iTotalCnt;
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For a detailed comment refer to the initial code. Apart from some naming differences, the main
parts of interest are:

» 150 - 151: if our average value is a number, then we're done

» 155: fetch the data source. Our CreateWaveformFromAverage class is derived from the
SampleBySampleOrNumericalFunction class that is derived from the
FirstArgumentFunction which is derived from the base class FunctionBase. Within this
base class there is a m_Parameters]] array that comprises all passed data sources. Since
we only have one parameter we need to address the first one which is m_Parameters[0].

+ 168: fetch all data. For this we need to know the start time and end time of the complete
waveform. This information is available through the Sweeps property of the data source.

Now we are done with our function implementation.

You could test it by creating a formula in the formula database and compare it with the initial
method:

test = @CSI_MeanWave (CSIDemo.MyResult)
Compare test with MyResultAve. They should be identical.

The last step would be to verify the new formula by extending our example sheet. To do this
we add a new group box with a single button see picture below;

SheetControl.cs [Design]

Acquisition contral Analysis Calculations Using Formula D atabase
Maw - Max Pog: - Min: -

Min: - i Min Pog.. -
LCalculate Calculate

Span Channel 1
Span: Get

Set

Settings

Signal coupling Input coupling

- w

Dizplay

PISPLAY
" |
el

"
-

O
I:;‘-:]I_I\"i earvave test

? Caleulate

The code behind the button click looks like:

1149
1150
1151
1152
1153
1154

private void btnCreateMeanWave Click (object sender, EventArgs e)
{
// Get Active Trace
DTrace myTrace = displayl.pDisplay.TimeDisplay.ActiveTrace;
if (myTrace == null)

{

106
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1155

1156
1157
1158
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1163
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1175
1176
1177
1178
1179
1180
1181
1182

1183
1184

1185
1186

1187
1188
1189

1190
1191
1192
1193
1194
1195
1196
1197

1198

PerceptionMessageBox.Show(this, "No active trace found",
"CSI Display Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;
}
// Get datasource from active trace
IDataSrc iActiveTrace = myTrace.TraceProp.DataSrc;
if (iActiveTrace == null)
{
PerceptionMessageBox.Show(this, "Active trace has no datasource",
"CSI Display Demo", MessageBoxButtons.OK, MessageBoxIcon.Error) ;
return;

// Get Data source name from trace e.g.:
// "Active.Groupl.Recorder B.Burst"
string cDSName = myTrace.TraceProp.DataSourceName;

// create required formulas in formula database

// create instance of formula database
FormulaDB ForDB = FormulaDB.Instance;

// check if formula already exist
if (ForDB.Formulas|["poc"] == null)
{
// search for an empty line
foreach (Formula frml in ForDB.Formulas)
{
if (frml.IsEmpty())
{
// Define Name, Formula and Units (See columns formula
// database sheet)
frml.Name = "poc";
frml .Expression = string.Format("@Cut ({0}
Display.CSIDisplay.Cursorl.XPosition;
Display.CSIDisplay.Cursor2.XPosition)", cDSName) ;
ForDB.Formulas[frml.LineNumber + 1] .Name = "test";
ForDB.Formulas[frml.LineNumber + 1] .Expression =
"@CSI_MeanWave (Formula.poc)";

// fetch units from source

ForDB.Formulas[frml.LineNumber + 1].Units =
iActiveTrace.YUnit;
break;

// Add the trace to the display
DTrace TestTrace;

displayl.pDisplay.TimeDisplay.CtlLayout.ActivePane.Traces.AddDataSource (
out TestTrace, "Formula.test");

If you compile and run the code you will see the same average trace as before. See picture
below.
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Aequizition control Analysiz Calculations Using Formula Database

Maw - Max Pos.: - M!"
[ — MinPog:  — Min Poz.:
Acquisition state: T Gl Segments: =T
LCalculate Calculate

Span Channel 1

I

Span: et

100.0 %

Settings

Signal coupling Input coupling

Dizplay

Clear Digplay t[secl 5457
Active Cursor Y¥alue

7 | Page1 ]

C5I_Mean'w ave test

| Calculate
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If you look into the formula sheet then you will see the following formulas:

ﬂ Farmula

Mum Mame | Formula Units

poc utlactrve Groupl.Recorder_B.Burst; Dizplay. izplay. Curzorl =Fozition; Dizplay. izplay. Curzord =Foszihon
1 @Cutfadive. G 1.Recorder_B.B Dizplay. C510izplay. C 1.%Puogition; Dizplay. CS1Dizplag. C 2 #Pozition]
2 test @C5]_MeantwaveFormula poc) b

Note: since we are using the cursor position in the formulas, moving the cursors will
rebuild the cut out segment. When we would have used the actual numbers the result
would have been fixed.

In addition: although the cut out segment updates, the average value will not since we use a

test:

if (!'double.IsNaN(m_Average))
return;

I.e. when the average value is already calculated we quit. We could omit this test, but then we
run into trouble with our multi-tasking, multi-threading software. To overcome this we need a
few more lines of code.

In the CreateWavefromFromAverage we need to override the Reset method. This method is
called whenever the function needs to 'restart’, e.g. when new data arrives, or data is modified.
In this method we must reset our average value:

|| m_Average = double.NaN;

However, when doing so, we may not be interrupted. Therefore:
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8.6

public override void Reset()

{
lock (this)

{

m_Average = double.NaN;

Also we do not want interruptions when we do the actual calculations. So:

protected override SampleBySampleDataSegment CreateWrapperSegment
(IDataSegment OriginalSegment)
{
lock (this)
{
CalculateAverageOfSource() ;
return new AverageWrapperSegment (OriginalSegment, m_Average) ;

By "locking" pieces of code we are sure that no other thread can interrupt our work while
making sensitive calculations.

Summary

In these last two chapters we have seen a variety of functionality required to implement your
own analysis:

* The datamanager as central point of information on all (types of) data.
» Fetch and use existing waveforms, numerical values and strings.

+  Create your own waveforms, numerical values and strings and perform some basic math
while creating them.

* Measurement cursors manipulation.

* Use the formula database as a waveform calculator.

+  Create your own functions to be used within the formula database.

One important choice you will need to make when doing your own analysis: do you want to
create new results that become available as "non-volatile" data or are "volatile" formula

database interim results acceptable?

The Perception CSI offers both: the choice is yours. And you can always combine both
options.
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9 Automation

With everything said and done so far only two issues remain to be discussed: reporting and
automation. Since reporting by itself is something that cannot be controlled from within the CSI
we will discuss in this chapter some automation issues and include command to print out a
predefined report.

As an example we will discuss a typical type of application: set the acquisition parameters,
start acquisition. After the acquisition do some analysis and print a report.

9.1 Example: post-acquisition analysis and reporting
Our example is based on a real application where an object is tested by dropping a weight on
it. Forces on the three axis are measured and the resultant force is calculated. The value of
interest is the time the resultant force is above a certain level.

9.1.1 Procedure

The signals of X-, Y- and Z-transducers are each fed to a separate input channel. The
recording is made with a sample rate of 10000 samples per second.

The recording has two sweeps: the first one is used as calibration data and triggered just
before the actual impact is recorded in the second sweep.

The required calculations can be done in the formula database:

+ for each channel subtract the mean value of the first sweep from the second sweep to
compensate for any offset,

» calculate the result as the square root of the sum of squares of the three channels,

* measure the time above two predefined levels.
In our example we will also position the cursors on the points of interest.
We will start with this example from scratch. To minimize the work involved by an operator and
to reduce the chance on errors we will do as much as possible in our code. We also want to
make sure that test information (e.g. a Device Under Test serial number) has been entered

before the actual print out is made.

We assume that we are working in a fixed environment with a single recorder with four
channels with predefined names.

9.1.2 Beforeyou begin

Before you begin create a new project as described earlier. For your convenience here is the
procedure with some modifications.

To start you new project proceed as follows:

1 Start your Microsoft Visual Studio, and select File > New > Project.
2 Inthe dialog that comes up select a Visual C# Windows project.

3 Select the Perception CSI Sheet template

4  Enter a name and location for this project and click OK
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The Solution Explorer will now include the following:

Solution Explorer

=22 E] B
j Solution "tyFirstCEL (1 project)
4 |5 MyFirstCs1
4 |7 Properties
] Assemblynfo.cs
4 (3 Resources.resx
% Resources.Designer.cs
a | References
«3J PerceptionInterfaces
<30 Perception Interaps
0 Systermn
-3 System.Data
<3 Systerm Drawing
-3 System Windows, Farms
-3 System Xml
4 [ Resources
] Sheetlconico
4 [# SheetControl.cs
4 SheetControl.Designer.cs
#] SheetControllnfoProvider.cs
] SheetControllnfoRetriever.cs

A reference to the Perception.Interfaces

C# code for the SheetControl

This code is sufficient to create a sheet in Perception. Before we can actually build it we need
to add some more information to the project itself.

Optionally give the sheet a name and icon other than default:

Go to Resources > Strings and modify the text from IDS_USERNAME into your sheet

Go to Resources > Icons and select Add Resource > Add Existing File. Browse to and

Verify the output path: C:\Program Files\HBM\Perception\Sheets\

Go to Build > Configuration and select Release or Active (debug). When you want to
debug include in Debug > Start Action the Start external program: C:\Program

1 Goto Project > Project Name Properties
2
name
3
select your own icon file.
4 Remove the default icon
5 Rename your icon into "Sheetlcon"
Mandatory:
1 Goto Project > Project Name Properties
2 Go to Build > Output > Output path
3
4
Files\HBM\Perception\Perception.exe.
5 Inthe main menu select Build > Build Solution

When all is OK, no error messages are generated. Ignore warnings for the time being.

When error messages are generated verify all of the above steps. Also make sure you have
the latest version of the template and the latest version of Perception.
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9.1.3 User interface

For the user interface we need a Start button, a Print Report button (could be done also
automatically), a display that shows the three compensated signals as well as the resultant
and two meters, one for each level. In addition a status field can be used for various
messages. Look in the Data Visualization section how you can add a Display and Meter to the
sheet.

>
(9]

SheetControl.c:

—_—

[Design] | ‘

Actions l

[ stat [ Piintreport [ide

Results

PIsPLAY

)

O———
Q

—
[m]

A. Start button StartCmd

B. Print Report button ReportCmd

C. Status messages text label StatusArea

D. Perception display component ResultDisplay (Perception.CSIl.Support.PerceptionDisplay)
E. Perception meter component ResultMeters (Perception.CSl.Support.PerceptionMeter)

The Perception components should be available in the Toolbox of the Designer. If not so,
reload them.

To add the Perception components
1 Go to the SheetControl Design layout.
2 Inthe Toolbox select one of the tab headers and do a right mouse click.

3 Inthe context menu that comes up select Add Tab and give it a relevant name like
"Perception Components".
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4 With this tab selected do a right mouse click.

5 Inthe context menu that come up select Choose Items ...

6 Inthe dialog that comes up select Browse...

7 Navigate to the Perception folder. Typically: C:\Program Files\HBM\Perception.

8 Select the file Perception.Components.dll and click Open.

9 Click OK in the Choose Toolbox Items dialog.

Now the components are added to the toolbox.

Since we are still doing the user interface we can also add at this point the menu entries and

the toolbar.

To add items to the dynamic menu you must create a context menu strip in the sheet user
interface. This menu is not actually deployed, but used as a piece of menu transferred to the

dynamic menu.

To add items to the dynamic menu

1 Inthe programming environment add a tool strip menu to your user interface: Toolbox >
Menus & Toolbars > ContextMenuStrip

2 Use Edit Items ... to add/modify menu items

Jizis Collzetiug Editur
Select item and add to list below:
= Menultem | v

Members:
FE| contextMenuStripl

&= PrintCmd_Menultem

ToolStripMenultem

B

DisplayStyle
Font
ForeColor
Image
Imagealign
ImageScaling

ImageTransparentColor [_|

RightToLeft

RightToLeftautoMirrorIm False
ShortcutKeyDisplayString

Text

Textalign

TextDirection

TextImageRelation
El Behavior

s

StartCmd_Menultem

ImageAndText

Tahoma; 8.25pt

Il ControlText
System.Drawing.